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Symantec Software License Agreement

IMPORTANT:  PLEASE READ THE TERMS AND 
CONDITIONS OF THIS LICENSE AGREEMENT 
CAREFULLY BEFORE USING THE SOFTWARE.  
SYMANTEC CORPORATION AND/OR ITS 
SUBSIDIARIES ("SYMANTEC") IS WILLING TO 
LICENSE THE SOFTWARE TO YOU AS THE 
INDIVIDUAL, THE COMPANY, OR THE LEGAL 
ENTITY THAT WILL BE UTILIZING THE 
SOFTWARE (REFERENCED BELOW AS "YOU" 
OR "YOUR") ONLY ON THE CONDITION THAT 
YOU ACCEPT ALL OF THE TERMS OF THIS 
LICENSE AGREEMENT.  THIS IS A LEGAL AND 
ENFORCEABLE CONTRACT BETWEEN YOU 
AND SYMANTEC.  BY OPENING THIS 
PACKAGE, BREAKING THE SEAL, CLICKING 
THE "ACCEPT" OR "YES" BUTTON OR 
OTHERWISE INDICATING ASSENT 
ELECTRONICALLY, OR LOADING THE 
SOFTWARE, YOU AGREE TO THE TERMS AND 
CONDITIONS OF THIS AGREEMENT.  IF YOU 
DO NOT AGREE TO THESE TERMS AND 
CONDITIONS, CLICK THE "I DO NOT ACCEPT" 
OR "NO" BUTTON OR OTHERWISE INDICATE 
REFUSAL, MAKE NO FURTHER USE OF THE 
SOFTWARE, AND CONTACT SYMANTEC 
CUSTOMER SERVICE FOR INFORMATION ON 
HOW TO OBTAIN A REFUND OF THE MONEY 
YOU PAID FOR THE SOFTWARE (LESS 
SHIPPING, HANDLING, AND ANY 
APPLICABLE TAXES EXCEPT IN CERTAIN 
STATES AND COUNTRIES WHERE SHIPPING, 
HANDLING, AND TAXES ARE REFUNDABLE) 
AT ANY TIME DURING THE SIXTY (60) DAY 
PERIOD FOLLOWING THE DATE OF 
PURCHASE.

1. License:
The software and documentation that 
accompanies this license (collectively the 
"Software") is the property of Symantec, or its 
licensors, and is protected by copyright law.  
While Symantec continues to own the Software, 
You will have certain rights to use the Software 
after Your acceptance of this license.  This 
license governs any releases, revisions, or 
enhancements to the Software that Symantec 
may furnish to You.  Except as may be modified 
by a Symantec license certificate, license 
coupon, or license key (each a "License 
Module") that accompanies, precedes, or 
follows this license, Your rights and obligations 
with respect to the use of this Software are as 
follows.

You may:
A. use one copy of the Software on a single 
computer.  If a License Module accompanies, 
precedes, or follows this license, You may make 
the number of copies of the Software licensed to 
You by Symantec as provided in Your License 
Module. Your License Module shall constitute 
proof of Your right to make such copies;
B. make one copy of the Software for archival 
purposes, or copy the Software onto the hard 

disk of Your computer and retain the original 
for archival purposes;
C. use the Software on a network, provided that 
You have a licensed copy of the Software for 
each computer that can access the Software 
over that network;
D. after written notice to Symantec, transfer the 
Software on a permanent basis to another 
person or entity, provided that You retain no 
copies of the Software and the transferee agrees 
to the terms of this license; and
E. use the Software in accordance with any 
additional permitted uses set forth below.

You may not:
A. copy the printed documentation that 
accompanies the Software; 
B. sublicense, rent, or lease any portion of the 
Software; reverse engineer, decompile, 
disassemble, modify, translate, make any 
attempt to discover the source code of the 
Software, or create derivative works from the 
Software; 
C. use the Software as part of a facility 
management, timesharing, service provider, or 
service bureau arrangement;
D. use a previous version or copy of the 
Software after You have received and installed 
a disk replacement set or an upgraded version. 
Upon upgrading the Software, all copies of the 
prior version must be destroyed; 
E. use a later version of the Software than is 
provided herewith unless You have purchased 
upgrade insurance or have otherwise 
separately acquired the right to use such later 
version;
F. use, if You received the software distributed 
on media containing multiple Symantec 
products, any Symantec software on the media 
for which You have not received a permission 
in a License Module; 
G. use the Software in any manner not 
authorized by this license; nor
H. use the Software in any manner that 
contradicts any additional restrictions set forth 
below.

2. Content Updates:
Certain Software utilize content that is updated 
from time to time (including but not limited to 
the following Software: antivirus software 
utilize updated virus definitions; antispam 
software utilize updated antispam rules; 
content filtering software utilize updated URL 
lists; some firewall software utilize updated 
firewall rules; and vulnerability assessment 
products utilize updated vulnerability data; 
these updates are collectively referred to as 
"Content Updates").  You shall have the right to 
obtain Content Updates for any period for 
which You have purchased maintenance, 
except for those Content Updates that 
Symantec elects to make available by separate 
paid subscription, or for any period for which 



You have otherwise separately acquired the 
right to obtain Content Updates.  Symantec 
reserves the right to designate specified 
Content Updates as requiring purchase of a 
separate subscription at any time and without 
notice to You; provided, however, that if You 
purchase maintenance hereunder that includes 
particular Content Updates on the date of 
purchase, You will not have to pay an additional 
fee to continue receiving such Content Updates 
through the term of such maintenance even if 
Symantec designates such Content Updates as 
requiring separate purchase. This License does 
not otherwise permit the licensee to obtain and 
use Content Updates.

3. Product Installation and 
Required Activation:
There are technological measures in this 
Software that are designed to prevent 
unlicensed or illegal use of the Software.  You 
agree that Symantec may use these measures 
to protect Symantec against software piracy.  
This Software may contain enforcement 
technology that limits the ability to install and 
uninstall the Software on a computer to not 
more than a finite number of times for a finite 
number of computers.  This License and the 
Software containing enforcement technology 
require activation as further set forth in the 
documentation.  The Software will only operate 
for a finite period of time prior to Software 
activation by You.  During activation, You will 
provide Your unique product key 
accompanying the Software and computer 
configuration in the form of an alphanumeric 
code over the Internet to verify the authenticity 
of the Software.  If You do not complete the 
activation within the finite period of time set 
forth in the documentation, or as prompted by 
the Software, the Software will cease to function 
until activation is complete, which will restore 
Software functionality.  In the event that You 
are not able to activate the Software over the 
Internet, or through any other method specified 
during the activation process, You may contact 
Symantec Customer Support using the 
information provided by Symantec during 
activation, or as may be set forth in the 
documentation.

4. Sixty (60) Day Money Back 
Guarantee:
If You are the original licensee of this copy of 
the Software and are not completely satisfied 
with it for any reason, please contact Symantec 
Customer Service for a refund of the money You 
paid for the Software (less shipping, handling, 
and any applicable taxes except in certain 
states and countries where shipping, handling 
and taxes are refundable) at any time during 
the sixty (60) day period following the date of 
purchase.

5. Limited Warranty:
Symantec warrants that the media on which the 
Software is distributed will be free from defects 
for a period of sixty (60) days from the date of 
delivery of the Software to You. Your sole 

remedy in the event of a breach of this warranty 
will be that Symantec will, at its option, replace 
any defective media returned to Symantec 
within the warranty period or refund the money 
You paid for the Software.  Symantec does not 
warrant that the Software will meet Your 
requirements or that operation of the Software 
will be uninterrupted or that the Software will 
be error-free.

TO THE MAXIMUM EXTENT PERMITTED 
BY APPLICABLE LAW, THE ABOVE 
WARRANTY IS EXCLUSIVE AND IN LIEU 
OF ALL OTHER WARRANTIES, WHETHER 
EXPRESS OR IMPLIED, INCLUDING THE 
IMPLIED WARRANTIES OF 
MERCHANTABILITY, FITNESS FOR A 
PARTICULAR PURPOSE, AND 
NONINFRINGEMENT OF INTELLECTUAL 
PROPERTY RIGHTS.  THIS WARRANTY 
GIVES YOU SPECIFIC LEGAL RIGHTS. 
YOU MAY HAVE OTHER RIGHTS, WHICH 
VARY FROM STATE TO STATE AND 
COUNTRY TO COUNTRY.

6. Disclaimer of Damages:
SOME STATES AND COUNTRIES, 
INCLUDING MEMBER COUNTRIES OF 
THE EUROPEAN ECONOMIC AREA, DO 
NOT ALLOW THE LIMITATION OR 
EXCLUSION OF LIABILITY FOR 
INCIDENTAL OR CONSEQUENTIAL 
DAMAGES, SO THE BELOW LIMITATION 
OR EXCLUSION MAY NOT APPLY TO YOU.

TO THE MAXIMUM EXTENT PERMITTED 
BY APPLICABLE LAW AND REGARDLESS 
OF WHETHER ANY REMEDY SET FORTH 
HEREIN FAILS OF ITS ESSENTIAL 
PURPOSE, IN NO EVENT WILL 
SYMANTEC OR ITS LICENSORS BE 
LIABLE TO YOU FOR ANY SPECIAL, 
CONSEQUENTIAL, INDIRECT, OR 
SIMILAR DAMAGES, INCLUDING ANY 
LOST PROFITS OR LOST DATA ARISING 
OUT OF THE USE OR INABILITY TO USE 
THE SOFTWARE EVEN IF SYMANTEC HAS 
BEEN ADVISED OF THE POSSIBILITY OF 
SUCH DAMAGES.

IN NO CASE SHALL SYMANTEC'S OR ITS 
LICENSORS' LIABILITY EXCEED THE 
PURCHASE PRICE FOR THE SOFTWARE.  
The disclaimers and limitations set forth 
above will apply regardless of whether You 
accept the Software.

7. U.S. Government Restricted 
Rights:
RESTRICTED RIGHTS LEGEND. All Symantec 
products and documentation are commercial in 
nature.  The software and software 
documentation are "Commercial Items," as that 
term is defined in 48 C.F.R. section 2.101, 
consisting of "Commercial Computer Software" 
and "Commercial Computer Software 
Documentation," as such terms are defined in 
48 C.F.R. section 252.227-7014(a)(5) and 48 



C.F.R. section 252.227-7014(a)(1), and used in 
48 C.F.R. section 12.212 and 48 C.F.R. section 
227.7202, as applicable.  Consistent with 48 
C.F.R. section 12.212, 48 C.F.R. section 
252.227-7015, 48 C.F.R. section 227.7202 
through 227.7202-4, 48 C.F.R. section 52.227-
14, and other relevant sections of the Code of 
Federal Regulations, as applicable, Symantec's 
computer software and computer software 
documentation are licensed to United States 
Government end users with only those rights as 
granted to all other end users, according to the 
terms and conditions contained in this license 
agreement.  Manufacturer is Symantec 
Corporation, 20330 Stevens Creek Blvd., 
Cupertino, CA  95014.

8. Export Regulation:
Certain Symantec products are subject to 
export controls by the U.S. Department of 
Commerce (DOC), under the Export 
Administration Regulations (EAR) (see 
www.bxa.doc.gov). Violation of U.S. law is 
strictly prohibited. You agree to comply with 
the requirements of the EAR and all applicable 
international, national, state, regional and local 
laws, and regulations, including any applicable 
import and use restrictions.  Symantec products 
are currently prohibited for export or re-export 
to Cuba, North Korea, Iran, Iraq, Libya, Syria 
and Sudan or to any country subject to 
applicable trade sanctions.  You agree not to 
export, or re-export, directly or indirectly, any 
product to any country outlined in the EAR, nor 
to any person or entity on the DOC Denied 
Persons, Entities and Unverified Lists, the U.S. 
Department of State's Debarred List, or on the 
U.S. Department of Treasury's lists of Specially 
Designated Nationals, Specially Designated 
Narcotics Traffickers, or Specially Designated 
Terrorists.  Furthermore, You agree not to 
export, or re-export, Symantec products to any 
military entity not approved under the EAR, or 
to any other entity for any military purpose, nor 
will You sell any Symantec product for use in 
connection with chemical, biological, or nuclear 
weapons or missiles capable of delivering such 
weapons.

9. General:
If You are located in North America or Latin 
America, this Agreement will be governed by 
the laws of the State of California, United States 
of America. Otherwise, this Agreement will be 
governed by the laws of England and Wales.  
This Agreement and any related License 
Module is the entire agreement between You 
and Symantec relating to the Software and:  (i) 
supersedes all prior or contemporaneous oral or 
written communications, proposals, and 
representations with respect to its subject 
matter; and (ii) prevails over any conflicting or 
additional terms of any quote, order, 
acknowledgment, or similar communications 
between the parties. This Agreement shall 
terminate upon Your breach of any term 
contained herein and You shall cease use of and 
destroy all copies of the Software.  The 
disclaimers of warranties and damages and 
limitations on liability shall survive 
termination.  Software and documentation is 

delivered Ex Works  California, U.S.A. or 
Dublin, Ireland respectively (ICC INCOTERMS 
2000).  This Agreement may only be modified 
by a License Module that accompanies this 
license or by a written document that has been 
signed by both You and Symantec.  Should You 
have any questions concerning this Agreement, 
or if You desire to contact Symantec for any 
reason, please write to: (i) Symantec Customer 
Service, 555 International Way, Springfield, OR 
97477, U.S.A., (ii) Symantec Consumer 
Support, PO Box 5689, Dublin 15, Ireland, or 
(iii) Symantec Customer Service, 1 Julius Ave, 
North Ryde, NSW 2113, Australia.

10. Additional Uses and 
Restrictions:
A.  You may use the Software on one computer 
to clone, or apply an image of a hard drive on 
that computer, or to another hard drive on the 
same computer, a replacement computer, 
secondary media, or network drive.
B. You may use the Software on a computer to 
create an image file of a hard drive on that 
computer and store the image file on fixed or 
removable media for disaster recovery 
purposes.
C. You may use the Software as a boot disk to 
re-apply the hard drive image that was created 
for disaster recovery purposes to the hard drive 
on the computer from which the disaster 
recovery image was made or on a replacement 
computer provided that the software has been 
removed from the original computer.
D. You may use the Software to clone a hard 
drive from a computer to a replacement 
computer, in the manner described in the 
Software documentation and to use the 
Software on the replacement computer 
provided that the Software has been removed 
from the original computer.
E. You may not use the Software commercially 
or non-commercially for the purpose of creating 
multiple computers or hard drives, except for 
multiple hard drives installed in or attached 
directly to the original computer.
F. If the Software You have licensed includes 
the Symantec Recovery Disk ("Component") the 
following uses and restrictions apply to the 
Software:
(i) The Component contains Windows(R) 
software licensed from Microsoft Corporation. 
Microsoft Corporation has no liability to You for 
the Component.  Any support for the 
Component will be provided by Symantec in 
accordance with Symantec's then-current 
support guidelines.
(ii) THE COMPONENT CONTAINS A TIME-OUT 
FEATURE THAT WILL AUTOMATICALLY RE-
BOOT THE COMPUTER AFTER TWENTY-FOUR 
HOURS OF CONTINUOUS USE. THIS TIME-OUT 
FEATURE WILL RESET EACH TIME THE 
COMPONENT IS RE-LAUNCHED.
(iii) The Component may be used as a boot, 
diagnostic, disaster recovery, setup, 
restoration, emergency service, installation, 
test, and configuration utility program.  Use of 
the Component as a general purpose operating 
system or as a substitute for a fully functional 



version of any operating system product is 
strictly prohibited.
G. For the purposes of this License Agreement, 
a virtual machine is considered the same as an 
actual machine.

Windows(R) is a registered trademark of 
Microsoft Corporation.
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Responding to 
emergencies 1
About responding to emergencies

If you have an emergency, such as lost or corrupted files 
or folders, or you cannot start Windows, review this 
chapter for steps you can take to restore files, folders, or 
your entire computer.

If you have been running Norton Ghost for very long, it is 
very likely that you have a backup you can use to restore 
your computer back to a time before the problems 
occurred.

Deciding what action to take
Review the following table to determine which action you 
can take to solve your emergency:

Problem Recovery method

You can start Windows 
on the computer, but 
you have lost files, 
folders, programs, or 
hardware files on a 
drive (excluding 
Windows files).

Recover selected files and folders from within 
Windows using a current recovery point. 

See “About recovering files or folders” on page 81.
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You should also review the troubleshooting section for 
solutions to many common problems. 

See “Troubleshooting Norton Ghost” on page 125.

You can start Windows 
on the computer, but 
you have lost a 
secondary drive, such 
as a D or E drive.

Recover a drive from within Windows using a 
current recovery point.

See “About Recovering a drive” on page 89.

You cannot start 
Windows, but you know 
which files you need to 
recover your computer.

Recover selected files and folders from within the 
Symantec recovery environment using a current 
recovery point.

See “Recovering files and folders from the recovery 
environment” on page 104.

You cannot start 
Windows and you do 
not know the cause.

Recover your entire computer from within the 
Symantec recovery environment using a current 
recovery point.

See “Recovering your computer” on page 93.

Problem Recovery method



Feature summary

2
Overview

Norton Ghost provides advanced backup and recovery for 
your computer. Protect your documents, financial 
records, photos, music, videos, historical documents, or 
any other kinds of data you keep on your computer by 
making a backup of your computer's entire hard disk.

You can schedule backups to run automatically. Then, at 
any time, easily restore individual files, folders, or your 
entire computer.

What’s new in Norton Ghost
Norton Ghost 10 includes many enhancements and new 
features. 

w If you are familiar with earlier versions of Norton Ghost, 
review the readme file for information about changes in 
product terminology. For example, image files are now 
referred to as recovery points.

See “Viewing the Readme file” on page 43.
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Refer to the following table for information about the 
latest features and enhancements: 

Feature Description

Enhanced 
ease-of-use

An improved user interface simplifies 
what you need to know and do to 
successfully back up or recover files, 
folders, or your entire computer.

Easy Setup After activating your product, the Easy 
Setup dialog appears automatically. 
Specify a few preferences and Norton 
Ghost starts backing up your computer 
on a regular basis.

One-click 
backup

Quick access to your list of defined 
backups where you can select a 
specific backup and then start the 
backup with a single click. This feature 
is also available from the Norton Ghost 
system tray menu.

Simplified 
schedule 
editor

You can now easily edit your existing 
backup schedules without having to 
click through multiple dialogs or 
complete the entire backup wizard 
again.

Recovery 
points

Recovery points represent points in 
time. If you need to set your computer 
back a week to when it was working 
better, choose the recovery point 
created one week ago.

Optimize 
recovery point 
storage

Because recovery points require 
storage space, Norton Ghost gives you 
the freedom of where and how to 
handle the amount of disk space used 
for storing recovery points. Norton 
Ghost offers simple tools for managing 
your recovery points, and can even 
manage them for you automatically.
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Backup and 
recovery status

Now there is a single place you can go 
to see how protected each of your 
computer’s hard drives really are. Then 
you can increase or decrease the 
amount of protection a drive has; an 
excellent method for ensuring the 
drives you use most are completely 
protected when data loss happens.

Automatic 
recovery point 
storage 
detection

Norton Ghost automatically detects 
when a new storage device is 
connected to your computer, and can 
prompt you to change your default 
recovery point storage location to the 
new drive. 

Browse files 
and folders 
inside a 
recovery point

Enhanced browsing of files and folders 
inside recovery points, making 
recovery quick and easy.

Event-
triggered 
backups

In addition to scheduled and manual 
backups, Norton Ghost can detect 
certain events and run a backup 
automatically whenever they occur, 
providing an added level of protection 
for your computer.

Performance 
throttling

Manually adjust the effect of a running 
backup on the performance of your 
computer to better match your needs 
at the moment. This feature is 
especially useful if you are working on 
your computer and don’t want the 
backup process to slow you down.

Encryption for 
recovery 
points

Encrypt recovery points and assign a 
password as a means of securing your 
information from intruders.

Feature Description
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How Norton Ghost works
Norton Ghost backs up your computer by taking a 
snapshot of your computer's entire hard disk. Each 
snapshot is stored on your computer as a recovery point—a 
point in time used to restore your computer (or individual 
files or folders) back to the way it was when the recovery 
point was created.

When you use Norton Ghost, you typically perform one or 
more of the following basic tasks: 

1 Define a backup

1 Run a backup

1 Manage recovery point storage

1 Recover files or folders

1 Recover an entire computer

Maxtor 
OneTouch™ 
integration

If you have a Maxtor OneTouch™ 
external hard drive, you can back up 
your computer with the push of a 
button. No need to start Ghost.

Enhanced 
Symantec 
Recovery Disk

When you cannot start Windows, the 
newly enhanced Symantec Recovery 
Disk (SRD) makes recovery easier than 
ever. Recovering your computer is 
more intuitive and requires fewer 
steps.

w If you purchased Norton Ghost 
pre-installed on a new computer, 
some features in the recovery 
environment may or may not be 
included, depending on how the 
computer manufacturer chose to 
install it. The recovery environment 
has likely been pre-installed on a 
special partition on your computer.

Feature Description
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Define a backup
When you install Norton Ghost and run it for the first 
time, the Easy Setup dialog box appears. From there, you 
define your first backup. 

Defining a backup requires that you specify certain 
settings that determine how and when the backup is run. 
Key settings you must define when defining a new 
backup, either from the Easy Setup dialog, or from the 
Define Backup Wizard, include the following: 

Settings Description

Name Because you can create multiple 
backups, specifying a name helps you 
identify a backup within a list of 
backups. 

For example, “Backup of C:” might be 
a name you assign to a backup that 
backs up your computer’s C drive.

Start time Choosing when a backup will run is 
important since a backup cannot run if 
your computer is turned off.
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Run a backup
A defined backup can be run manually or automatically, 
according to a schedule that you set up. Schedules can be 
set up either when you first define a backup or added to 
the backup at a later time.

While a backup is running, you can continue to work. 
However, depending on the amount of data that is being 
backed up and the number of programs you have 
running on your computer, you might need to reduce the 
speed of the backup in order to free up system resources 
for use by the programs you are using.

When the backup is complete, a message appears above 
the system tray to let you know that the backup was 
complete and successful.

Manage recovery point storage
Over time, your recovery point storage location can be 
used up. However, Norton Ghost includes powerful 

Recovery point 
storage 
location

Each time a backup runs, it creates a 
new recovery point. While you can 
specify a default location for recovery 
points, you can also specify an 
alternate location. Whatever location 
you specify is where recovery points 
will be created the next time the 
backup is run.

Event-
triggered 
backups

An event is an action that either you 
perform or that the computer 
performs. Norton Ghost can be set up 
to run a backup when an event occurs. 

For example, a backup can run each 
time you install new software onto 
your computer. This allows you to 
recover from an installation of a 
product that might cause problems on 
your computer.

Settings Description
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features for managing your recovery point storage 
location, including the ability to archive them to a hard 
drive, a USB or FireWire drive, a network drive, or to 
removable media, such as a writable DVD or CD.

Recover files or folders
When it becomes necessary to recover folders, files, or 
your entire computer, Norton Ghost makes it quick and 
easy.

By letting you browse through the contents of recovery 
points, it is as if you are looking at the original files and 
folders that existed on your computer when the recovery 
point was created. 

You can then select the files or folders to recover and 
restore them to your computer in seconds.

Advanced features let you search files and folders in a 
recovery point and then drag and drop them out of the 
recovery point into a folder on your computer. You can 
even mount a recovery point as if it were another drive 
on your computer and share it over a network. Files and 
folders can then be restored over your network.

Recover an entire computer
If you must restore your entire computer, simply put 
your Norton Ghost CD into your computer’s CD/DVD 
ROM drive and restart your computer to start the 
Symantec recovery environment.

The Symantec recovery environment lets you browse to 
one of your recovery points and start the recovery 
process. Within minutes, your computer restarts and is 
restored back to the date and time the recovery point you 
chose to use was first created.
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Installing Norton 
Ghost 3
System requirements 

Your computer must meet the following minimum 
requirements:

Operating system Windows 2000 SP4 or later, XP Home, or XP Pro

Other operating systems are supported by Norton Ghost

See “Support for older Windows versions” on page 24.

Processor Pentium 233 MHz

RAM 128 MB for Norton Ghost running on Windows 2000/XP

256 MB for Symantec Recovery Disk

Additional computer memory might be required when 
recovering your computer across a network from within 
the Symantec recovery environment.

Hard disk free 
space

45 MB for program files and an additional 40 MB for the 
Microsoft .NET 1.1 Framework, if it is not already installed

Storage space for your recovery points, unless you 
choose to store them to an alternate locations, such as a 
network computer or external hard disk.

DVD+R/RW, DVD-R/
RW, and CD-R/RW 
drives

Any speed

See a supported drives list at http://
service1.symantec.com/SUPPORT/powerquest.nsf/docid/
2004030176699562

http://service1.symantec.com/SUPPORT/powerquest.nsf/docid/2004030176699562
http://service1.symantec.com/SUPPORT/powerquest.nsf/docid/2004030176699562
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Supported file systems and removable media
Norton Ghost supports the listed file systems and 
removable media.

Support for older Windows versions
Norton Ghost 10 does not run on Windows 9x, Windows 
Me, or Windows NT Workstation 4.0. If you have one of 
these operating systems, you should use Norton Ghost 
2003, which is also included in the retail version of 
Norton Ghost.

For Norton Ghost 2003, your computer must meet the 
following minimum requirements:

Software Microsoft .NET Framework. After registration and when 
you open the Easy Setup dialog, you are prompted to 
install .NET if it is not already installed on the computer.

File Systems Norton Ghost is supported on FAT16, FAT16X, FAT32, FAT32X, 
NTFS, dynamic disks, Linux Ext2, Linux Ext3, and Linux swap 
partitions.

Removable 
Media

Norton Ghost supports the saving of recovery points locally 
(that is, recovery points that are created and saved on the 
same computer where Norton Ghost is installed) to most CD-R, 
CD-RW, DVD-R(W), and DVD+RW recorders on the market 
today. 

For an updated list of supported drivers, see the supported 
drives list at http://service1.symantec.com/SUPPORT/
powerquest.nsf/docid/2004030176699562.

It also supports saving recovery points to most USB devices, 
1394 FireWire devices, JAZ, Zip, SuperDisk, and magneto-
optical devices.

Norton Ghost does not support RAM drives.

Operating system Windows 9x/ME/NT Workstation 4.0

Norton Ghost 2003 can also run under Windows 2000 
Professional with 64 MB RAM and Windows XP 
Professional or Home with 128 MB RAM

http://service1.symantec.com/SUPPORT/powerquest.nsf/docid/2004030176699562
http://service1.symantec.com/SUPPORT/powerquest.nsf/docid/2004030176699562
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Installing Norton Ghost 
Install Norton Ghost from the Norton Ghost CD.

If you have not already done so, close all other Windows 
programs.

To install Norton Ghost

1 Uninstall any previous versions of Norton Ghost or 
Drive Image.

2 Plug in any USB storage devices you might want to 
use to store backups.

3 Insert the CD into the CD-ROM drive.
If the CD does not start automatically, double-click 
AUTOEXEC.EXE on the Norton Ghost 10 CD.

4 In the Norton Ghost window, click Install Norton 
Ghost.

5 In the Welcome window, click Next.
If the install detects a previous version of Norton 
Ghost or Drive Image on your system, you must first 
uninstall the software before you can install Norton 
Ghost 10.
Norton Ghost 10 can restore backup images created 
using Norton Ghost 9 and Norton Ghost 2003. If you 
want to keep your original schedules associated with 
backup jobs from an older version of Norton Ghost, 
including Drive Image, be sure to indicate during 
uninstall that you want to keep existing backups.

Processor Pentium-compatible processor

RAM 32 MB

Hard drive space 35 MB

CD drive Any speed

Floppy disk drive High-density
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6 Read the license agreement, then click I accept the 
terms in the license agreement.
If you decline, you cannot continue with the 
installation.

7 Click Next.

8 Confirm the installation location, and then click Next.

9 Click Install to begin the installation.

10 Click Finish to complete the installation.

11 After installation, click Yes to restart your computer.

After installation
At the end of installation and after your computer 
restarts, you are asked to activate your product and to 
specify a few basic settings that are used to define your 
first backup.

1 Activate your product

1 Set up your first backup

1 About the Symantec recovery environment

Activate your product
Product activation is a technology that protects users 
from pirated or counterfeit software by limiting use of a 
product to those users who have acquired the product 
legitimately. 

Product activation takes less than a minute to complete. 

If you choose not to activate the product when prompted, 
you will receive alerts that will remind you to activate the 
product. Activation should take just a few minutes. 

w You must activate the product within fifteen (15) days 
after installing it.

If you do not activate the product within the time period 
specified by the alerts, the product will stop working. You 
can activate it after the time period has elapsed, but you 
will not be protected until you do. 

Activation requires sending a unique product key to 
Symantec servers for each installation of the product.
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To activate your product at the end of installation

1 After your computer restarts at the end of the 
installation process, click Next on the Norton Ghost 
Welcome screen. 

2 Select one of the following options:

3 When prompted, enter your activation key.
If you are unsure where to find your product key, see 
Locate the product key.

4 After submitting your activation key, click Finish to 
open the Easy Setup dialog, which helps you define 
your first backup.
See “Set up your first backup” on page 28.

Locate the product key 
The product key can most frequently be found on a 
sticker on your CD sleeve. If it is not there, then it will be 
on an insert in your product package. If you have 
purchased the product on DVD, look for the sticker on 
your DVD package. If you have downloaded the product 
from the Symantec Store, the product key is stored on 
your computer as part of the download process. Or, if you 

Activate and 
register your 
product now 
(recommended).

Requires you to fill out 
registration information, such as 
your name and contact 
information. You are then 
required to enter your product 
activation key.

Activate your 
product now, but 
skip registration.

Skips the registration screens and 
prompts you for your product 
activation key.

Activate later. Reminds you that you have 15 
days until you must activate the 
product, after which time the 
product will no longer function.

See “If you choose to activate later” 
on page 28.
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purchased the product as part of your computer 
purchase, a temporary key is used by the computer 
manufacturer. At the time you activate your product, you 
will be issued a permanent key, which you should keep 
for future reference.

If you choose to activate later

If you choose not to activate during the Configuration 
Wizard, you can activate it later from within Norton 
Ghost.

w If you do not activate the product within 15 days of 
installing it, the product will stop working. However, you 
can still activate the product after the 15 days have 
elapsed.

To activate Norton Ghost after installation

1 Start Norton Ghost.

2 On the Status panel, click Activate Product and 
follow the on-screen prompts.

3 When prompted, enter your product key.
See “Locate the product key” on page 27.

Set up your first backup
After you activate and register your product, the Easy 
Setup dialog appears where you can quickly define your 
first backup.

To define your first backup

1 In the Easy Setup dialog box, enter a name for your 
first computer backup.

2 In the Start Time field, specify the time of day that the 
backup should start.

3 Specify the path to where recovery points created by 
your backup are to be stored. 

4 If you want a recovery point created any time a new 
software application gets installed, select the first 
option.

5 If you want the new backup to run immediately, select 
the second option.
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About the Symantec recovery environment
To ensure that you can access the recovery environment 
in the event that you need to restore your entire 
computer system, you should start the Symantec 
recovery environment. See “Starting your computer 
using the recovery environment” on page 94. 

If the recovery environment does not run as expected, 
you can take action early to fix the problem. Then if your 
backed up computer experiences a catastrophic failure 
later and Windows does not start, you will be assured 
that you can run the recovery environment to recover the 
system or your data. 

The troubleshooting section provides additional 
information to help you resolve issues that may exist 
with running the recovery environment on your system.

Here are the most common errors that you may see when 
you are having problems starting your computer from the 
Symantec Recovery Disk:

Your computer must be able to start 
from the Norton Ghost CD where the 
recovery environment is stored.

See “Cannot start the computer from 
the CD” on page 131.

You must have the necessary storage 
drivers to access your backups for a 
restore.

See “Cannot access the local drive 
where my backups are saved” on 
page 132.

You must have the necessary NIC 
drivers to access files on a network.

See “Cannot access the local drive 
where my backups are saved” on 
page 132.

You may need to use information 
about your system that you would 
not generally know.

See “I don’t know the system 
information that I’m required to 
enter” on page 125.
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Norton Ghost basics

4
Starting Norton Ghost

You can start Norton Ghost from the Windows taskbar or 
from the Windows system tray.

To start Norton Ghost

4 Do one of the following:
2 On the classic Windows taskbar, click Start > 

Programs > Norton Ghost > Norton Ghost.
2 On the Windows XP taskbar, click Start > All 

Programs > Norton Ghost > Norton Ghost.

Starting Norton Ghost from the system tray
Norton Ghost adds an icon to the Windows system tray. 
By default, the Norton Ghost tray icon appears in the 
lower-right corner of your computer monitor on the 
Windows taskbar.

To start Norton Ghost from the system tray

1 In the Windows system tray, double-click the Norton 
Ghost tray icon.

Using the Norton Ghost system tray menu

From the tray icon, you can quickly access the following 
Norton Ghost tools and information:

1 Create an immediate backup of one or more drives

1 Define a new backup

1 Edit existing backup schedules
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1 Restore your entire computer

1 Restore individual files and folders

1 Start Norton Ghost

1 View the progress and performance of a currently 
running backup

1 Cancel a currently running backup

1 Display the product license and version number

1 Check the backup and recovery status of your 
computer

To display the tray icon menu

4 Right-click the tray icon to display a quick menu of 
frequently used Norton Ghost tools.

Finding your way around Norton Ghost
Norton Ghost 10 is designed to do most of the work of 
backing up your computer for you. After initial setup, 
Norton Ghost can back up your entire computer on a 
regular basis. 

However, there are many features you can use at any 
time to ensure that your data is backed up and that your 
backups are being managed in a way that works for you. 

For example, you might have just created some critical 
documents or installed new software. You can use the 
Back Up Now feature to start a backup immediately to 
ensure that you have backed up the work. Or you might 
want to adjust the schedule of your backups, change the 
location of where your recovery points are stored, or 
clean up older backups that are taking up valuable hard 
disk space.
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Here are the three primary views, or panels, within 
Norton Ghost: 

Backup panel
The Backup panel groups all of the key backup features 
for configuring, scheduling, and backing up your 
computer. 

The Backup panel appears as the first screen when you start 
Norton Ghost and gives you access to the following key 
backup features:

Backup Gives you access to all key backup 
features of Norton Ghost needed 
for configuring, scheduling, and 
backing up your computer.

Recovery Lets you restore your entire 
computer back to a date and time 
when it was working normally, 
restore files and folders, and 
explore, manage, and optimize 
recovery points.

Status Gives you information about your 
computer’s backup and recovery 
protection status so that you can 
make sure your computer is 
backed up.

Back Up Now Opens a list of currently defined 
backups where you can run one 
immediately, or define a new 
backup.

Edit My Backup 
Schedules

Opens Edit Backup Schedules 
where you can edit schedules you 
have defined in current backups, 
or schedules that were 
automatically defined for you 
during the initial setup of Norton 
Ghost.
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Recovery Panel
The Recovery panel groups all of the key recovery 
features for recovering files, folders, or your entire 
computer. It also lets you explore recovery points using 
Microsoft Explorer, as well as optimize the hard disk 
space being used for storing recovery points of your 
computer.

View Progress and 
Performance

Displays the progress of any 
backup that is currently running 
and lets you adjust the 
performance speed of the backup. 

Adjusting the backup speed 
affects the performance of your 
computer during the backup. If 
you are working on your computer 
and don’t want the backup to 
affect the speed of your computer, 
you can set the backup speed to 
slow, freeing up most of the 
computer’s resources being used 
by the backup process. 

Copy My Hard Drive 
(Advanced)

When you need to install a new 
hard disk (or a second hard disk), 
this feature copies all existing 
files, programs, and settings 
directly onto the new disk.

w If you are using a trial 
version of Norton Ghost 10, this 
feature is not available. To use 
this feature, you must purchase a 
fully licensed version of Norton 
Ghost 10.
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The Recovery panel gives you access to the following key 
recovery features:

Status panel
The Status panel provides information about how well 
protected your computer is by indicating how many 
recovery points exist for each of your computer’s hard 
drives, and identifies the last time a recovery point was 
created. It also provides an event log, which displays 
information, errors, or warnings that occur.

The Status panel contains the following key status 
features:

Recover My 
Computer

Restores your computer to a 
specific day and time when it was 
working correctly. 

Recover My Files Recovers files or folders you 
choose from within a recovery 
point that have been lost, 
damaged, changed, or 
accidentally deleted.

Explore Recovery 
Points (Advanced)

Lets you explore the files and 
folders stored in an existing 
recovery point using Microsoft 
Explorer.

Optimize Recovery 
Point Storage

Optimizes the hard disk space 
being used for storing recovery 
points of your computer.

Check Backup and 
Recovery Status

Displays backup and recovery 
protection status in a single view. 
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Configuring Norton Ghost default options
The Options dialog box includes four tabs that let you 
configure the following default settings:

View Event Log Displays information, errors, and 
warnings that occur within the 
product.

Purchase the 
Product

If you are using an evaluation 
copy of Norton Ghost, this option 
indicates how many days remain 
for the trial period, and also 
provides easy online access for 
purchasing a licensed copy of the 
product.

After you have upgraded, this 
option changes to show your new 
product license. 

Tab Description

Settings Specify a default location where a 
backup will create and store 
recovery points. If the location 
where you want to create your 
recovery points is on a network, 
you can enter your user 
authentication information.

See “Selecting a default recovery 
point storage location” on page 37.

Notifications If you want a history of actions 
taken by Norton Ghost, or of error 
messages and warnings, you can 
choose to save them in a log file 
on your computer, or to have 
them emailed to an address you 
specify.

See “Enabling email notifications” 
on page 38.
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To configure default options

1 Start Norton Ghost and click Options.

2 Select a tab containing the options you want to 
modify, make any necessary changes, and then click 
OK.

Selecting a default recovery point storage 
location

You can specify the default location for storing recovery 
points created when you run a backup. This default 
location is used if you do not specify a different location 
when you define a new backup.

Performance Lets you specify a default speed 
for backup or recovery processes. 
Moving the slider closer to Fast 
increases the speed at which the 
program backs up or recovers your 
computer. However, choosing a 
slower speed could improve the 
performance of your computer, 
especially if you are working on 
your computer during a backup or 
recovery. 

w During a backup or recovery, 
you have the option to override 
this default setting to fit your 
needs at the time.

Tray Icon You can turn the system tray icon 
on or off and specify whether to 
show only error messages when 
they occur, or to show both error 
messages and other information, 
such as the completion of a 
backup.

Tab Description
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w After installation, when the Easy Setup dialog appeared, 
you should have specified a default recovery point 
storage location.

To set a default recovery point storage location

1 On the menu bar, click Options.

2 Click the Settings tab.

See “About 
selecting a recovery 
point storage 
location” on 
page 58.

3 Enter a path to a default location for recovery points, 
or click Browse to look for a location.

4 If you entered the path to a location on a network, 
enter the user name and password required to 
authenticate to the network.

5 Click OK.

Enabling email notifications
Email notifications can be sent to a specified email 
address if there are any errors or warnings that occurred 
when a backup is run.

w If you do not have an SMTP server, this feature is 
unavailable to you.

All notifications are automatically sent to the system 
event log and a custom log file located in the Agent folder 
of the product installation. 

If notifications are not being delivered, check the setup of 
your SMTP server to ensure that it is functioning 
properly.

To enable email notifications

1 On the main menu bar, click Options.

2 Click the Notifications tab.

3 Select SMTP E-mail from the Notifications Are Sent 
to the Following list, and then click Properties.

4 Select one or more of the following options:
2 Errors
2 Warnings
2 Information
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5 In the To address text box, type the email address (for 
example, admin@domain.com) where notifications 
are to be sent. 

6 If desired, type the email address of the sender in the 
From address text field.
If you do not specify a From address, the name of the 
product will be used. 

7 In the SMTP server text box, type the path to the 
SMTP server that will send the email notification (for 
example, smtpserver.domain.com).

8 From the SMTP Authentication drop-down box, select 
the method to use to authenticate to the SMTP server 
specified above.

9 Click OK.

Adjusting the effects of a backup on computer 
performance

If you are working on your computer when a backup is 
running—especially one that is creating an independent 
recovery point—your computer might slow down. This is 
because Norton Ghost is using your computer’s hard disk 
and memory resources to perform the backup. 

However, you can actually modify the speed of the 
backup as a way of minimizing the impact of Norton 
Ghost on your computer while you work. 

To adjust my computer’s speed during a backup

1 On the main menu bar, click Options.

2 Click the Performance tab.

3 If you want to improve your computer’s speed 
performance, move the slider bar closer to Slow.

4 If you want the backup to complete more quickly, 
move the slider bar closer to Fast.

5 Click OK.

w During a backup or recovery, you’ll have the option of 
overriding this default setting to fit your needs at the 
time. 

See “Adjusting the speed of a backup” on page 65.
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Enabling network throttling

Similar to computer performance adjustments, you can 
also limit the impact of a backup on network 
performance.

To enable network throttling

1 On the main menu bar, click Options.

2 Click the Performance tab.

3 Check Enable network throttling.

4 Click OK.

Adjusting default tray icon settings
You can turn the system tray icon on or off and specify 
whether to show only error messages when they occur, 
or to show both error messages and other information, 
such as the completion of a backup.

To adjust default tray icon settings

1 On the main menu bar, click Options.

2 Click the Tray Icon tab and select one of the 
following:

3 Click OK.

Show system tray 
icon

Displays the Norton Ghost icon in 
the system tray.

Only show error 
messages

Displays only error messages as 
they occur.

Show all status 
and error 
messages

Displays all messages as they 
occur.



Norton Ghost basics
Viewing the backup and recovery status of your computer

41

Viewing the backup and recovery status 
of your computer

You can view the backup and recovery status of your 
computer to determine the current level of protection for 
each of the drives on your computer.

This is an excellent method for making sure your 
backups are current so that you are prepared to recover 
your computer from potential problems.

See “Monitoring the status of your backups” on page 69.

Browsing recovery points
You can actually view the files and folders contained 
within recovery points, restore individual program and 
data files and folders, and even mount a recovery point to 
make it appear as an actual drive that can be shared 
across a network.

See “About recovering files or folders” on page 81.

You can use additional, more advanced recovery point 
browser features included with Norton Ghost.

See “Advanced exploring of recovery points” on page 85..

Keeping current with LiveUpdate
Using your Internet connection, you can use LiveUpdate 
to obtain program updates for your computer.

Program updates are minor improvements to your 
installed product. These differ from product upgrades, 
which are newer versions of entire products. Program 
updates that have self-installers to replace existing 
software code are called patches. Patches are usually 
created to extend operating system or hardware 
compatibility, adjust a performance issue, or fix bugs.

LiveUpdate automates the process of obtaining and 
installing program updates. It locates and obtains files 
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from an Internet site, installs them, and then deletes the 
leftover files from your computer.

When you should update
Run LiveUpdate as soon as you have installed your 
product. Once you know that your files are up-to-date, 
run LiveUpdate periodically to obtain program updates. 
For example, to keep all installed Symantec products 
current, you may want to use LiveUpdate once a week. 
Program updates are released by Symantec on an as-
needed basis.

Obtaining updates using LiveUpdate
LiveUpdate checks for updates to all of the Symantec 
products that are installed on your computer. 

To obtain updates using LiveUpdate

1 At the top of the main window, click LiveUpdate. 

2 In the LiveUpdate window, click Next to locate 
updates. 

3 If updates are available, click Next to download and 
install them. 

4 When the installation is complete, click Finish.
Some program updates may require that you reboot 
your computer before the changes will take effect. 

Obtaining updates from the Symantec Web site
When new updates become available, Symantec posts 
them on the Symantec Web site. If you can't run 
LiveUpdate, you can obtain new updates from the 
Symantec Web site. 

Visit http://www.symantec.com/downloads/.

For more information
The product documentation provides glossary terms, 
online Help, a Readme file, and the User’s Guide in PDF 
format.

http://www.symantec.com/downloads/
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1 Using online Help

1 Viewing the Readme file

1 Accessing the User’s Guide PDF

Using online Help
Help is available throughout your Symantec product. 
Help menus to more information provide information 
related to the dialogs you are currently using. The Norton 
Ghost Help menu item on the Help and Support menu 
(accessed from the main Norton Ghost panel) provides a 
comprehensive guide to all of the product features and 
tasks that you can complete.

To use online Help

1 At the top of the main window, click Help & Support 
> Norton Ghost Help.

2 In the Help window, in the left pane, select a tab. Your 
options are:

Viewing the Readme file
The Readme file contains information about installation 
and compatibility issues. It also contains technical tips 
and information about product changes that occurred 
after this guide went to press. It is installed on your hard 
drive in the same location as the product files.

To read the Readme file

1 In Windows Explorer, double-click My Computer. 

2 Double-click the hard disk on which you installed 
Norton Ghost 10.
In most cases, this will be drive C.

3 Click Program Files > Norton Ghost > Shared.

Contents Displays the Help by topic

Index Lists Help topics in alphabetical 
order by key word

Search Opens a search field in which you 
can enter a word or phrase
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4 Double-click Readme.txt.
The file opens in Notepad or your default word 
processing program.

5 Close the word processing program when you are 
done reading the file.

Accessing the User’s Guide PDF
The Norton Ghost User’s Guide is provided on the CD in 
PDF format. You must have Adobe Acrobat Reader 
installed on your computer to read the PDF.

To read the User’s Guide PDF from the CD

1 Insert the CD into the CD drive.

2 Using Windows Explorer, double-click the \Docs 
folder on the CD.

3 Double-click UserGuide.pdf to open the Norton 
Ghost user’s guide.
You can also copy the User’s Guide to your hard disk 
and read it from there.



Backing up your 
computer 5
Best practices for backing up

You can manually back up your computer at any time by 
running a defined backup. But you can also configure a 
defined backup to run automatically on a regular basis.

To save you time and to ensure a reliable backup 
strategy, review these sections as you prepare to back up 
your computer.

1 Before backing up

1 During a backup

1 After defining your backup

Before backing up
Before defining and running your first backup, consider 
these best practices:

Best practice Explanation How to

Schedule backups 
when you know your 
computer will be 
turned on.

Your computer must be 
running for a backup to 
run.

See “Defining a new 
backup” on page 49.

See “Editing a backup 
schedule” on page 66.
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Use a secondary hard 
disk as your recovery 
point storage 
location

Storing recovery points 
on a hard disk other 
than your primary hard 
disk, such as C, is the 
most secure method of 
ensuring you can recover 
in the event that your 
primary hard disk fails.

See “About selecting a 
recovery point storage 
location” on page 58.

Run backups on a 
regular (frequent) 
basis

When you define your 
backups, schedule them 
to run frequently so that 
you have recovery points 
that span at least the last 
two months.

See “Editing a backup 
schedule” on page 66.

See “Running an existing 
backup immediately” on 
page 55.

See “Enabling event-
triggered backups” on 
page 57.

Define one backup 
for each drive

When defining backups, 
you should define one 
backup for each drive. 
For example, define a 
scheduled backup for C, 
another scheduled 
backup for D, and if you 
have a E drive on your 
hard disk that you rarely 
use, you might set up a 
manual backup that you 
can run whenever you 
think it necessary.

See “Defining a new 
backup” on page 49.

See “Running an existing 
backup immediately” on 
page 55.

Best practice Explanation How to
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During a backup
While a backup is running, consider the following best 
practices:

Keep your personal 
data and programs 
on a separate drive 
from where Windows 
is installed

Separating Windows 
from your own data 
speeds the creation of 
recovery points and 
reduces the amount of 
information that could 
need to be restored. For 
example, keep C as your 
Windows drive and then 
use D as your data drive 
where you install new 
programs and store files 
and folders you create.

If you’re computer already 
has a secondary drive that 
has a large amount of disk 
space available, you can 
adopt this strategy today. 

If your computer is not set 
up this way, you can use 
Norton PartitionMagic to 
resize your C drive and 
create additional drives. 

Visit http://
www.symantec.com/
partitionmagic/

Improve your 
computers 
performance during a 
backup

If a backup is run while 
you are working on your 
computer and you notice 
that the performance of 
your computer has 
slowed down, you can 
reduce the speed of the 
backup to improve 
computer performance 
until you are finished 
working.

See “Adjusting the effects of 
a backup on computer 
performance” on page 39.

Use the Verify recover 
point after creation 
option to ensure the 
stability of recovery 
points

When defining a backup, 
you should select the 
Verify recovery point 
after creation option to 
ensure that the recovery 
point can be used to 
recover lost data, if and 
when you might need to.

See “Defining a new 
backup” on page 49.

Best practice Explanation How to

http://www.symantec.com/partitionmagic/
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After backing up
After a backup has finished running, consider the 
following best practices:

Best practice Explanation How to

Improve your 
computer’s 
performance during a 
backup

If a backup is run while 
you are working on your 
computer and you notice 
that the performance of 
your computer has 
slowed down, you can 
reduce the speed of the 
backup to improve 
computer performance 
until you are finished 
working.

See “Adjusting the effects of 
a backup on computer 
performance” on page 39.

Best practice Explanation How to

Review the contents 
of recovery points

Ensure that you are 
backing up essential 
data by periodically 
reviewing the contents of 
recovery points.

See “Viewing files and 
folders in a recovery point” 
on page 83.

Review the events log 
to verify backups 
have happened and 
to spot any potential 
problems

Periodically review the 
event messages found in 
the View Events Log 
window. This feature 
records events when 
they occur, such as 
backups and any errors 
that might have occurred 
during or after a backup.

See “Verifying that a backup 
is successful” on page 56.
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Defining a new backup
The first step in backing up your computer is to define a 
backup. A backup is a description of what you want 
backed up and where you want to keep the recovery 
points created when the backup is run.

A backup might also include a schedule, indicating a date 
and time when you want the backup to run.

w When you ran Norton Ghost for the first time, you should 
have created a default backup in the Easy Setup dialog. If 
you didn’t create a default backup, the Easy Setup dialog 
appears when you click Define New Backup from the 
Back Up Now dialog.

To define a new backup

1 On the Backup panel, click Back Up Now.

Optimize recovery 
point storage

Delete outdated recovery 
points and consolidate 
incremental recovery 
points as a method for 
freeing up hard disk 
space for more current 
recovery point.

See “Deleting a recovery 
point set” on page 76.

See “Deleting recovery 
points within a set” on 
page 76.

See “About recovery points” 
on page 73.

Review the level of 
protection being 
provided for each of 
your computer’s 
drives

Check the Backup and 
Recovery Status panel on 
a regular basis to ensure 
each drive has a defined 
backup.

See “Viewing the level of 
backup protection for each 
drive” on page 69.

See “Changing drive 
protection levels” on 
page 71.

Maintain duplicate 
recovery points for 
safety

Store recovery points 
elsewhere on a network, 
or create CDs, DVDs, or 
tapes of recovery points 
for off-site storage in a 
safe and secure place.

See “Archiving recovery 
points” on page 77.

Best practice Explanation How to
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2 In the Back Up Now window, click Define New 
Backup.

3 Click Next on the first panel of the Define Backup 
Wizard.

4 Select which drives you want backed up, and then 
click Next.

5 If you selected a drive that has not yet been included 
in a backup, you might be asked if you want to add the 
selected drive to an existing backup, or if you want to 
continue to define a new backup. 
If you choose to add the drive to an existing backup, 
the Wizard finishes and you are done. 
If you select Define a new custom backup, click Next 
and continue with the Define Backup Wizard.

6 Select one of the following types of backups:

Recovery point 
set

Creates a base recovery point with 
additional recovery points that 
contain only incremental changes 
made to your computer since the 
creation of the base recovery 
point. Incremental recovery points 
are created faster than the first 
(base) recovery point and use less 
storage space than an 
independent recovery point.

If the Recovery Point Set option is 
disabled, it is because you have 
already assigned a selected drive 
to an existing recovery point set 
and you can only have one 
recovery point set defined for 
each drive. Or, you might have 
selected an unmounted drive that 
cannot be part of a recovery point 
set.

Independent 
recovery point

Creates a complete, independent 
copy of the drives you selected. 
This backup type requires more 
storage space.
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7 Click Next.

8 Click Browse to locate a folder for storing recovery 
points, and then click Next.

See “Selecting a 
default recovery 
point storage 
location” on 
page 37.

9 In the Name field, enter a name for your new backup.

See “About setting 
a compression 
level” on page 61.

10 In the Compression drop-down list, select one of 
following compression levels:
2 None
2 Standard (Recommended)
2 Medium
2 High

See “Verifying a 
recovery point after 
creation” on 
page 63.

11 If you want to determine whether a recovery point is 
valid immediately following its creation, click Verify 
recovery point after creation.

12 If you want to limit the total number of independent or 
recovery point sets saved for each drive, select the 
check box and specify the number in the Maximum 
field.

13 In the Description text box, type a description that 
you want associated with each recovery point that will 
be created.

See “Setting 
advanced backup 
options” on 
page 62. 

14 If you want to set additional options such as adding a 
password to the recovery points, click Advanced.

15 When you finish setting the advanced options, click 
OK to return to the Wizard.

16 Select one of the following methods to choose when 
the backup should be run:

Manually (No 
Schedule)

Select this option if you want this 
backup to run only when you 
choose to run it yourself.

Scheduled Select this option if you want to 
specify dates and times when 
Norton Ghost should run the 
backup for you.
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1 : 

17 If you chose Manually, click Next and skip to Step 21. 
If you chose Scheduled, click Define Custom 
Schedule.
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18 If you selected recovery point set as your recovery 
point type, refer to the following table for information 
about your options:

Tab Description

Scheduling 1 Click Schedule recovery point 
creation and then check the days 
and a start time for when each 
incremental recovery point is 
created.

Alternatively, you can uncheck 
Schedule recovery point 
creation and run the backup only 
when specific events occur. 
See “Enabling event-triggered 
backups” on page 57.

1 If you want changes you make to 
files on your computer captured 
more than once each day, select 
Create more than one recovery 
point per day and specify now 
many and how much time should 
elapse between each capture.

1 If you chose to create more then 
one incremental recovery point per 
day and you want Norton Ghost to 
optimize them, click the 
Automatically optimize drop-
down list and select how often 
optimization should occur.

1 Click the Start a new recovery 
point set drop-down list to specify 
how frequently a new recovery 
point set should be started.

Event 
Triggers

Select which events should 
automatically start the backup.

See “Enabling event-triggered backups” 
on page 57.
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If you selected independent recovery point as your 
recovery point type, refer to the following table for 
information about your options:

19 Click OK, and then click Next.

20 Click Next to review the backup options you have 
selected.

21 If you want to run the new backup immediately, click 
Create the first recovery point now.

22 Click Finish.

After defining your backup
All backups you define are automatically saved so that 
you can edit or run them later. There is no need to 
remember to save a backup or the recovery points 
created by a backup, although archiving recovery points 

Option Description

Weekly A complete, independent copy of the 
drives you include in the backup are 
created at the time and days of the 
week you specify.

Monthly A complete, independent copy of the 
drives you include in the backup are 
created at the time and days of the 
month you specify.

Only run 
once

One independent recovery point is 
created at the date and time you 
specify.

Manually 
(no 
schedule)

Save all the backup settings except the 
schedule. You can later run the backup 
at your convenience by selecting the 
Backup panel and clicking Back Up 
Now.

You can assign a schedule at a later 
time by selecting the Backup panel and 
clicking Edit My Backup Schedules.
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to CD or DVD is an excellent way of ensuring you have a 
backup available, even if your hard disk crashes.

After defining and scheduling backups, exit Norton 
Ghost. The program does not need to be open for a 
backup to run. After you define a backup and schedule it 
to run on a specific date and at a specific time, you can 
exit the program.

However, you’re computer must be running at the time a 
backup is to occur. If your computer is not running, the 
backup will not occur until the next scheduled time (if it 
is scheduled) and if the computer is turned on.

Running an existing backup immediately
You can run a backup at any time, provided you have one 
defined. 

See “Defining a 
new backup” on 
page 49.

This is particularly useful when you are about to install a 
new product and want to make sure you have a current 
recovery point in the event that something goes wrong 
with the installation.

w Norton Ghost can be configured to run a backup 
automatically when an event occurs on your computer, 
such as installing a new software program. 

See “Enabling event-triggered backups” on page 57..

Also, it is a great way to ensure you have a backup of 
your work after you have modified a large number of files 
and you don’t want to wait for a regularly scheduled 
backup.

w When running a backup, you should exit any partitioning 
software that is running, such as Norton PartitionMagic. 
Also, you should not run any disk defragmenting 
software during a backup.

To run an existing backup immediately

1 On the Backup panel, click Back Up Now.

2 Select a backup from the list, and then click Back Up 
Now to run the selected backup.
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w You can also schedule backups to run automatically on a 
reoccurring schedule. 

See “Editing a backup schedule” on page 66..

Verifying that a backup is successful
When a backup is completed, you have three methods for 
ensuring that the backup contains valid data:

1 Select the Verify recovery point after creation option 
when you define a backup.
See “Defining a new backup” on page 49.

1 Browse the contents of a recovery point to make sure 
the files you wanted to back up are included.
See “Viewing files and folders in a recovery point” on 
page 83.

1 Review the event log for information about 
successfully completed backup and other information 
and error messages.

For the last option, you can use the View Event Log 
feature to review information and errors related to your 
backups.

To verify the success of a backup using the events log

4 On the Status panel, click View Event Log.

About the Event Log
The event log should be the first place you check when 
tracking down the source of problem or to verify the 
successful completion of a backup. 

Log entries provide information and clues to the success 
or failure of numerous actions taken either by Norton 
Ghost or by a user. It offers a single, easy to read view of 
all information and program error messages.
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Event details provided by the events log include:

Files not included in recovery points
The hibernate.sys and pagefile.sys files are intentionally 
excluded from backups. These files contain temporary 
files that can take up a large amount of disk space. They 
are not needed and there will be no negative impact on 
your computer system after a complete system recovery. 

Even though these files appear in recovery points, they 
are only placeholders.

Enabling event-triggered backups
In addition to scheduled and manual backups, Norton 
Ghost can detect certain events and run a backup 
whenever they occur. 

For example, to protect your computer when you install 
new software, Norton Ghost can run a backup when it 
detects that new software is being installed. In the event 
that the software harms your computer, you can “undo” 
the install by restoring your computer using the recovery 
point created when Norton Ghost ran the backup.

Type Indicates if the event is an error 
message or other information, such 
as the successful completion of a 
backup.

Source Identifies if the message was 
generated by Norton Ghost or 
another program.

Date Displays the exact date and time 
that a selected event occurred.

Description Offers additional details about an 
event that can give valuable clues 
to any problems that might have 
occurred.



Backing up your computer
About selecting a recovery point storage location

58

Norton Ghost can run a backup when: 

1 Any application is installed

1 Any user logs on to the computer

1 Any user logs off from the computer

1 The data added to a drive exceeds an amount (in 
megabytes) you specify

1 The Maxtor OneTouch•  (an external hard drive) 
button has been pushed.

To enable event-triggered backups

1 On the Backup panel, click Edit My Backup 
Schedules.

2 Select the backup schedule that includes the drives 
you want backed up after an event occurs, and then 
click Edit Schedule.

3 Click the Event Triggers tab.

4 Select the events you want Norton Ghost to detect, 
and then click OK.

About selecting a recovery point storage 
location

When deciding where to store recovery points, you 
should carefully review the following information.

w If you choose to use CDs or DVDs as your recovery point 
storage location (not recommended), you cannot back up 
to a sub-folder on the disk. Recovery points must be 
created at the root of CDs and DVDs.
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Recovery 
point 
storage 
location

Information to consider

On the 
computer 
being 
backed up

Use this method to store recovery points on the computer that is 
being backed up. It is possible to save recovery points to the 
same hard disk that you are backing up; however, it is not 
recommended because as the number or size of recovery points 
grow, you will have less disk space available for regular use. 

In addition, the recovery points themselves are then included in 
subsequent backups of the drive, increasing the size of those 
backups.

w If you choose this option and then attach a second hard 
disk, such as an external USB drive, Norton Ghost automatically 
detects the new drive and asks if you want to use the new drive 
for recovery point storage. This is because using a secondary 
hard disk is the optimal recovery point storage location.
Saving recovery points to a separate drive, a network location, 
or removable media eliminates this problem.

You can use Norton PartitionMagic to create new partitions 
(drives) on your computer hard disk that are dedicated to storing 
recovery points.

Network 
file

If your computer is connected to a network, you can save your 
recovery points to a network folder.

CD-RW/
DVD-RW

When you save recovery points to removable media, they are 
automatically split into the correct sizes if the backup spans 
more than one media. 

The scheduling of backups is not available when this option is 
used.

w Using CD-RWs or DVD-RWs as your recovery point storage 
location is not the best option because you will be required to 
swap disks during the process. 



Backing up your computer
About selecting a recovery point storage location

60

The following table gives you additional information 
regarding the advantages and disadvantages of different 
types of storage locations for recovery points. 

Location Advantages Disadvantages

Hard drive

(recommended)

1 Fast backup and recovery

1 Can schedule unattended 
backups

1 Inexpensive because 
drive space can be 
overwritten repeatedly

1 Uses valuable drive space

1 Vulnerable to loss if the 
hard drive fails

Network drive

(recommended)

1 Fast backup and recovery

1 Can schedule unattended 
backups

1 Inexpensive because 
drive space can be 
overwritten repeatedly

1 Protection from local 
hard drive failure

1 Off-site storage (through 
existing network backup 
strategies)

1 Must have supported NIC 
drivers to restore from 
the recovery 
environment

1 Must understand and 
assign the appropriate 
rights for users who will 
run backups and restore 
data

USB or FireWire 
drive

(recommended)

1 Fast backup and recovery

1 Can schedule unattended 
backups

1 Inexpensive because 
drive space can be 
overwritten repeatedly

1 Off-site storage is 
possible

1 Reserves hard drive space 
for other uses

1 Additional expense for 
the drive itself

1 Must have supported 
storage device drivers to 
restore from the 
Symantec Recovery Disk 
CD; could require 
additional media along 
with the Symantec 
Recovery Disk CD
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About setting a compression level
Compression results may vary depending on the types of 
files saved in the drive you are backing up.

Removable 
media (local)

1 Protection from hard 
drive failure

1 Ideal for off-site storage

1 Reserves hard drive space 
for other uses

1 Cannot create 
unattended backups; 
process is manual

1 Cannot create recovery 
point sets; independent 
recovery points only

1 Media can be expensive

1 Recovery can be slower 
than from other 
locations, especially for 
individual files and 
folders

1 You cannot save recovery 
points to DVD-RAM drives 
under Windows 2000

1 Requires swapping of 
disks and can be very 
time-consuming

Location Advantages Disadvantages

Compression 
level

Description

None This is the best option if storage space is not an issue. 
However, if the backup is being saved to a busy network 
drive, using high compression may be faster than no 
compression because there is less data to write across the 
network.

Standard Uses low compression for a 40% average data compression 
ratio on recovery points. This is the default.

Medium Uses medium compression for a 45% average data 
compression ratio on recovery points.
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Setting advanced backup options 
You can set the following additional options when 
creating a recovery point.

High Uses high compression for a 50% average data compression 
ratio on recovery points. This is usually the slowest method.

When a high compression recovery point is created, CPU 
usage may be higher than normal. Other processes on the 
computer may also be slower.

Compression 
level

Description

Option Action

Use 
password

This option sets a password on the recovery point that is 
created. Passwords can use standard characters, not extended 
characters or symbols. (Use characters with an ASCII value of 128 
or lower.)

A user must type this password before restoring a backup or 
viewing the contents of the recovery point.

Use 
encryption

You can encrypt your password to add another level of 
protection to your recovery points. You can choose from low 
(8+ character password), Medium (16+ character password), or 
High (32+ character password) encryption levels.

Divide into 
smaller files 
to simplify 
archiving

You can split the recovery point into smaller files and specify 
the maximum size (in MB) for each file. 

For example, if you plan to copy a recovery point to ZIP disks 
from your recovery point storage location, specify a file size of 
100 MB or less, according to the size of each ZIP disk.

w When archiving to CDs or DVDs, this is done for you 
automatically.

Ignore bad 
sectors 
during copy

This option lets you run a backup even if there are bad sectors 
on the hard drive. Although most drives do not have bad 
sectors, the potential for problems increases during the 
lifetime of the hard drive.
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To set advanced backup options

1 In the Advanced Options dialog box, click Use 
password, and then type the password and 
confirmation password.

2 To encrypt the password, check Use encryption, 
click the drop-down list, and then select a level of 
encryption to match the number of characters in your 
password. 
The higher the encryption level chosen, the more 
number of characters are required in your password.

To ignore bad sectors during copying

4 In the Advanced Options dialog box, click Ignore bad 
sectors during copy.

To disable SmartSector copying

4 In the Advanced Options dialog box, click Disable 
SmartSector Copying. 

Verifying a recovery point after creation
If this option is selected, the recovery point is checked to 
see that all of the files in the recovery point are available 
for you to open, the internal data structures in the 
recovery point match the data that is available, and the 
recovery point can be un-compressed to create the 
expected amount of data (if you selected a compression 
level at the time of creation).

w Be aware that verifying a recovery point can 
approximately double the time required to create the 
recovery point.

Disable 
SmartSector 
Copying

SmartSector technology speeds up the copying process by only 
copying clusters and sectors that contain data. However, in 
some cases, it may be desirable to copy all clusters and sectors 
in their original layout, whether or not they contain data.

This option lets you copy both used and unused clusters and 
sectors. Selecting this option increases processing time and 
usually results in a larger recovery point.

Option Action
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If you decide not to verify the recovery point at the time 
of creation, you can still check the integrity of a recovery 
point any time after it is created by opening it in the 
Recovery Point Browser.

Checking the integrity of a recovery point

You can verify a recovery point anytime after a backup is 
run to determine whether the recovery point is valid or 
corrupt. The Recovery Point Browser checks to see that 
all of the files in the recovery point are available for you 
to open, the internal data structures in the recovery point 
match the data that is available, and the recovery point 
can be un-compressed and create the expected amount of 
data.

To check the integrity of a recovery point

1 On the Recovery panel, click Recover My Files.

2 Do one of the following:
2 Select a recovery point from the list and click 

Browse Contents. 
2 If you don’t see the recovery point you are looking 

for, click View All Recovery Points on the 
toolbar.

3 In the tree panel of the Recovery Point Browser, select 
the recovery point.
For example, C_Drive001.v2i.

4 On the menu bar, click File > Verify Recovery 
Point.
If the Verify Recovery Point option is unavailable, you 
must first un-mount the recovery point. Right-click 
the recovery point and click Dismount Recovery 
Point.

5 When the check is complete, click OK.
If you prefer, you can have recovery points 
automatically verified for integrity at the time they 
are created. 
See “Verifying a recovery point after creation” on 
page 63.



Backing up your computer
About selecting a recovery point storage location

65

Back up dual-boot systems
You can back up dual-boot systems, or computers that 
are running more than one operating system, even if you 
have drives (partitions) that are hidden under the 
operating system where you run Norton Ghost. 

Everything on the drive you select will be included in the 
backup, so it will be bootable later if you restore it. An 
exception to this is if you back up a bootstrapped 
operating system, you must back up—and then restore—
every drive that includes operating system boot 
information in order for your computer to boot the same 
from a restored system as it did from the original 
configuration.

Viewing the progress of a backup
You can view the progress of a backup while it is running 
to determine how much time remains until the recovery 
point is created.

To view the progress of a backup

4 While a backup is running, click View Progress and 
Performance on the Backup panel.

Adjusting the speed of a backup
Depending on the speed of your computer, how much 
RAM you have installed, and the number of programs 
you are running during a backup, your computer could 
become sluggish.

However, you can manually adjust the effect of a backup 
on the performance of your computer to match your 
needs at the moment. This feature is especially useful if 
you are working on your computer and don’t want the 
backup process to slow you down.

To adjust the performance of a backup

1 While a backup is running, click View Progress and 
Performance on the Backup panel.

2 Do one of the following:
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2 If you want to increase the speed of your computer 
by reducing the speed of the backup, drag the 
slider toward Slow.

2 If you want the backup to complete as quickly as 
possible and you are not doing extensive work on 
your computer, drag the slider toward Fast.

3 When you are finished, click Hide.

Verifying that a backup completed
You can verify when a backup has completed 
successfully by opening the Backup and Recovery Status 
dialog.

To verify that a backup completed

4 On the Status panel, click Check Backup and 
Recovery Status.
See “Monitoring the status of your backups” on 
page 69.

Editing a backup schedule
You can edit any of the schedule properties for a defined 
backup.

To edit a backup schedule

1 In the Backup panel, click Edit My Backup 
Schedules.

2 In the list box, select a backup to edit.

3 Click Edit Schedule.

4 Make changes to the schedule, and then click OK.

Disabling a backup
You can disable or “turn off” a backup, and then re-
enable it later.

To disable a backup

1 In the Backup panel, click Edit My Backup 
Schedules.
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2 In the list box, select a backup to edit.

3 Click Edit Schedule.

4 Uncheck Enable Backup, and then click OK.

Adding users who can back up a 
computer

You can use the Norton Ghost Security Configuration 
Tool to give additional users and groups rights to access 
your copy of Norton Ghost.

To add users who can back up a computer

1 On the Windows taskbar, click Start > Programs > 
Norton Ghost > Security Configuration Tool. 

2 Click Add. 

3 In the Add Users and Groups window, select a user or 
group, then click Add.
The user or group will appear in the text box at the 
bottom of the window.

4 Click OK.

5 To delete users or groups, select a user or group, then 
click Remove.

6 In the Security Configuration Tool dialog box, click 
Close to exit the dialog box.

Deleting backups
You can delete backups when they are no longer needed.

To delete a backup

1 In the Backup panel, click Back Up Now.

2 In the list box, select a backup, and then click Tasks > 
Remove Backup.

3 Click Yes.
Deleting a backup does not delete recovery points 
from the storage location. Only the defined backup is 
deleted. But you can delete recovery points. 
See “Optimizing recovery point storage” on page 73..
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About monitoring backups

You should monitor your backups to ensure that you can 
effectively recover lost data whenever needed. Norton 
Ghost includes a Backup and Recovery Status panel 
where you can see which drives on your computer are 
protected, and how effectively they are protected. You 
can then add or remove protection, or adjust the 
schedules of any of your backups to better match the way 
you use your computer.

w In addition to ensuring that you are backing up each 
drive on your computer, you should carefully review and 
follow best practices for backing up your computer.

See “Best practices for backing up” on page 45.

Viewing the level of backup protection 
for each drive

You should review the level of backup protection being 
provided by your currently defined backups for each of 
the drives on your computer.

Norton Ghost provides a single place where you can 
quickly identify the level of backup protection for each 
drive on your computer.
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The following table identifies each level of backup 
protection assigned to each drive on your computer and 
describes the meaning of each level.

To view the status of backup protection

4 From the Status panel, click Check Backup and 
Recovery Status.

Icon Protection Level Meaning

Protected A backup is defined and is running on a 
regular basis.

A protected drive can be fully recovered.

Partially Protected A backup is defined, but is either not 
scheduled or has not been run for a long 
time, meaning that existing recovery 
points are probably old.

A partially protected drive can be 
recovered, but if the recovery points are 
older, it will not contain the latest 
versions of files or folders.

No Protection There is no defined backup and there are 
no recovery points available from which 
to recover the drive. 

An unprotected drive cannot be 
recovered and is at risk.
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About viewing other drive details
The Backup and Recovery Status dialog displays the 
following details of each drive:

Changing drive protection levels
The level of protection for a drive changes when you add 
or remove the drive from a defined backup, or when you 
modify how often the backup is run.

Drives that store information you modify frequently 
should be backed up regularly. For example, if you are 
making daily changes to drive C, you should make sure 
that drive is included in a backup and that the backup is 
run on a daily basis. By doing so, the protection level is 
increased. 

Name This is the name you assigned to 
the backup when you defined it.

By default, Norton Ghost assigns 
the default name, “Backup of 
drive”, where drive is the drive 
letter assigned to the drive to be 
backed up.

Type Identifies the type of recovery 
point the backup creates when it 
is run.

See “Defining a new backup” on 
page 49 for more information 
about types of recovery points.

Destination Identifies the recovery point 
storage location, or where the 
drive will be backed up.

Last Run Displays the day and time when 
the backup was last run.

Next Run Displays the day and time of the 
next scheduled backup.
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w A drive can be configured to be hidden. Hidden drives do 
not have a drive letter assigned to them. An asterisk (*) 
is used in place of a drive letter. 

To change the protection level

1 From the Status panel, click Check Backup and 
Recovery Status.

2 Select a drive from the list.

3 Select one of the following:

Add Protection Starts the Define Backup Wizard 
where you can define a backup for 
the selected drive.

Remove Protection Removes the selected drive from 
all defined backups.

Edit Schedule Modifes how frequently the drive 
is backed up.

Edit Settings Runs the Define Backup Wizard 
where you can modify settings of 
the selected backup.

Show Hidden 
Drives

Shows any hidden drives that 
might be configured on your 
computer.
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About recovery points

Recovery points require disk space. Norton Ghost 
includes features for keeping recovery points under 
control so that you can utilize disk space for other 
purposes.

Norton Ghost backs up your computer by taking a 
snapshot of everything stored on your computer's hard 
disk. Each snapshot is stored on your computer as a 
recovery point—a point in time used to recover your 
computer (or individual files or folders) back to the way it 
was when the recovery point was created.

There are two types of recovery points: independent 
recovery points and recovery point sets: 

Independent 
recovery point

Creates a complete, independent 
copy of the drives you selected. 
This backup type requires more 
storage space.

Recovery point 
set

Includes a base recovery point (a 
complete copy of your entire 
drive, similar to an independent 
recovery point) and additional 
recovery points that capture only 
incremental changes made to 
your computer since the creation 
of the base recovery point.
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Regardless of which type of recovery points your 
backups are creating, recovery points require space on 
your computer. If you keep too many, they can take up 
space you might want to use for other things.

You can manually optimize your recovery point storage, 
or you can let Norton Ghost do it for you.

Viewing the properties of a recovery point
At any time, you can view the properties of a recovery 
point to learn when it was created and how large it is. 

Here are the properties you can view:

To view the properties of a recovery point

1 On the Recovery panel, click Explore Recovery 
points (Advanced).

2 Right-click a recovery point in the list and click 
Properties.

Type Identifies the method of creation and type of recovery point 
made. 

For example, Manual Independent indicates that the 
recovery point was created manually (rather than 
automatically as the result of a defined schedule) and that it 
is an Independent recovery point.

Location The path to where the recovery point is stored.

Size The total size (in megabytes) of the recovery point.

Date The date and time when the recovery point was created.

Description The relative time from the present to when the recovery 
point was created. For example, “10 minutes ago”, or “15 
days ago”.
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Optimizing recovery point storage 
manually

Norton Ghost includes several features that help you 
optimize your recovery point storage space. The key is to 
prevent recovery points from taking up too much hard 
disk space on your computer while providing adequate 
backup protection in the event that you need to recover 
your computer, files, or folders.

To optimize recovery point storage manually

1 In the Recovery panel, click Optimize Recovery 
Point Storage.

2 From the Optimize Recovery Point Storage dialog box, 
you can do any of the following tasks:

Cleaning up old recovery points
Over time, you will end up with recovery points that you 
no longer need. For example, you might have several 
recovery points created months ago that you know you 
no longer need since you have more current ones 
containing your latest work. 

The Clean Up feature deletes all but the most current 
recovery point set, freeing up space on your hard disk for 
other uses.

w Once a recovery point is deleted, access to the files or 
system recovery from that point in time is no longer 

Clean Up  See “Cleaning up old recovery 
points” on page 75.

Delete Set  See “Deleting a recovery point set” 
on page 76.

Delete Points See “Deleting recovery points 
within a set” on page 76.

Archive See “Archiving recovery points” on 
page 77.
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available. If you are unsure, you might want to first 
explore the contents of the recovery point.

See “Viewing files and folders in a recovery point” on 
page 83. 

See “Advanced exploring of recovery points” on page 85.

To clean up old recovery points

1 In the Recovery panel, click Optimize Recovery 
Point Storage.

2 Click Clean Up on the toolbar.
Suggested recovery point sets that can be safely 
removed without eliminating your latest recovery 
point are selected for you. However, you can check or 
uncheck recovery point sets to specify which ones to 
remove.

3 Click Delete.
Once you delete a recovery point, access to file or 
system recovery from that point in time is no longer 
available. 

4 Click Yes to confirm the deletion.

Deleting a recovery point set
If you know that you no longer want a particular recovery 
point set, you can select and delete it at any time.

w Once you delete a recovery point, access to file or system 
recovery from that point in time is no longer available. 

To delete a recovery point set

1 In the Recovery panel, click Optimize Recovery 
Point Storage.

2 Select a recovery point set to delete from the list, and 
then click Delete Set on the toolbar.

3 Click Yes to confirm the deletion, and then click OK.

Deleting recovery points within a set
A recovery point set can contain multiple recovery points 
created over time that can be deleted to reclaim storage 
space.
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When you use the Delete Points option, all recovery 
points created between the first and last recovery point 
in the set are deleted. 

w Be careful about which recovery points you choose to 
delete. For example, if you created a new document that 
was then captured in the third recovery point in your 
recovery points list, but then you deleted the file 
accidently, at which time the deletion was captured by 
the fourth recovery point, you could lose the file 
permanently if you delete the third recovery point. If you 
are unsure, you can explore a recovery point before 
deleting it. 

See “Viewing files and folders in a recovery point” on 
page 83.

You can manually select which recovery points to 
remove, a helpful feature if you know which recovery 
points that you want to keep within a set.

To delete recovery points in a set

1 In the Recovery panel, click Optimize Recovery 
Point Storage.

2 Select a recovery point set from the list, and then click 
Delete Points on the toolbar.

3 To automatically delete all but the first and last 
recovery point in the set, click Automatic.

4 To manually select which recovery points in the set to 
delete, click Manual, and then select the recovery 
points you want deleted from the list.

5 Click OK.

Archiving recovery points
An excellent method of further protecting your computer 
is to archive recovery points to another location, such as 
another hard disk, another computer on a network, or on 
removable media such as DVDs or CDs. You can then 
store your backups somewhere remote from where you 
use your computer.

Archiving is also an effective method of freeing up hard 
disk space.
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To archive recovery points

1 In the Recovery panel, click Optimize Recovery 
Point Storage.

2 Select a recovery point set from the list, and then click 
Archive.

3 If you select a recovery point set containing multiple 
recovery points, select the ones you want to archive 
from the list of recovery points that appears, and then 
click OK.

4 Type the path to where you will archive your recovery 
points, or click Browse to browse to a location such as 
a DVD or CD burner.

5 If you are archiving to your hard disk but you plan on 
copying the archive to CDs or DVDs at a later point in 
time, select Divide into smaller files for archiving, 
and then enter a size in megabytes.

6 Select a level of compression for the archived 
recovery points. 
See “About setting a compression level” on page 61..

7 To prevent others from accessing the contents of your 
archived recovery points, click Use password, and 
then type a password containing eight or more 
characters.

8 Re-type the password to confirm it, and then select 
Encrypt recovery point if you want to add 
encryption to the file as an added security measure.
The higher the encryption level chosen, the more 
number of characters are required in your password. 
See the Use encryption drop-down list.

9 Click OK.

Automating management of recovery 
point storage

Norton Ghost can monitor your recovery point storage 
space and either notify you when it is getting too full, or 
automatically clean up old recovery points for you. You 
specify how much hard disk space is allowed for storing 
recovery points. When recovery points approach the 
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amount of space you specified, Norton Ghost notifies you. 
If you do not specify an amount, Norton Ghost notifies 
you when the disk reaches 90% of its total capacity. 

To configure automatic recovery point storage

1 In the Recovery panel, click Optimize Recovery 
Point Storage.

2 Click Options in the lower right corner.

3 Click Monitor disk space usage for recovery point 
storage, and then drag the slider to indicate the 
amount of disk space to be used for recovery point 
storage.
If you indicate that all disk space should be used, 
Norton Ghost notifies you when the disk reaches 90% 
of its total capacity.

4 Do one of the following:
2 If you want Norton Ghost to notify you when the 

storage size you specified is exceeded, click Warn 
me when recovery point storage exceeds 
threshold.

2 If you want Norton Ghost to manage the storage 
space for you without prompting you, select 
Automatically optimize storage.

When you select this option, Norton Ghost 
automatically deletes old recovery points to prevent 
them from exceeding the storage size you specified.

5 Click OK.

Changing your recovery point storage 
location

You can change your recovery point storage location at 
any time. For example, if you decide to purchase an 
external hard disk to store backups of your computer, 
you can then instruct Norton Ghost to start creating 
recovery points on the new hard disk. 

To change your recovery point storage location

1 In the Recovery panel, click Optimize Recovery 
Point Storage.
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2 Click Change Location.

3 In the Change Storage Location dialog box, click 
Browse to find the new recovery point storage 
location.

4 If you want only some of your currently defined 
backups to use the new location, uncheck any of the 
backups in the list that should not use the new 
backup location to store recovery points.

5 If you want any new backups you define to use this 
new location for recovery point storage, select Set as 
default storage location for recovery points.

6 Click OK.
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About recovering files or folders

Norton Ghost makes recovering files or folders easy. By 
letting you browse through the contents of recovery 
points, it is as if you are looking at the original files and 
folders that existed on your computer when the recovery 
point was created. 

w Before you can recover files or folders, you must have a 
recovery point already created. You cannot restore data 
on a computer if a recovery point of that computer does 
not exist.

If you are able to run Windows on a troubled computer, 
you can restore individual files or folders from a recovery 
point without having to exit Windows. 

w If you cannot run Windows, you might need to use the 
Symantec recovery environment. 

See “Recovering files and folders from the recovery 
environment” on page 104.

This method of recovery, sometimes known as a hot 
restore, is useful if you have traced the cause of a 
computer failure to a certain file or folder of files, or you 
have simply lost important files and do not want to 
restore your entire computer.

w If your recovery point is on removable media (DVD or 
CD), you can copy the recovery points to a fixed drive and 
restore files from the fixed drive. 
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To restore files or folders

1 Start Norton Ghost, and then click Recovery. 

2 Click Recover My Files.

3 Select a recovery point from the list, and then click 
Browse Contents.

4 To select the files or folders you want to restore, do 
one of the following:

5 Click Recover Files.
Where possible, the Recover Items dialog box will 
automatically fill in the Restore to this folder text field 
with the original path when the recovery point was 
created. If the original location does not include a 
drive letter (because the drive was hidden when you 
created the recovery point), you must enter a drive 
letter for the drive before you can restore any files or 
folders.

6 If the original path is unknown, or you want to restore 
the selected files to a different location, click Browse 
to locate the destination.

7 Click Recover Files to restore the files.
When file restoration is complete, you are returned to 
the Recovery Point Browser main window.

To select all items Press Ctrl+A

To select a group of 
files that are next 
to each other

Click the top file, then hold down 
Shift and click the last file in the list

To select a group of 
files that are not 
next to each other

Hold down Ctrl while selecting the 
files you want
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Viewing files and folders in a recovery 
point

If you are not sure what files you want to restore, you can 
open and view them from within a recovery point in the 
program associated with that file type. 

If a particular file type is not registered for viewing in a 
program, the Microsoft Open With dialog box is 
displayed. You can then select the program that you want 
the file to open in.

w You cannot view encrypted files system (EFS) NTFS 
volumes.

To view a file within a recovery point

1 Start Norton Ghost and click Recovery. 

2 Click Recover My Files.

3 Select a recovery point from the list and click Browse 
Contents.

4 In the Recovery Point Browser, select a drive in the 
tree panel (on the left).

5 In the content panel (on the right), double-click a 
folder that contains the file you want to view.

6 Select the file, and then click File > View File.
The View option is dimmed (unavailable) if you 
selected a program file that has a .exe, .dll, or .com file 
extension.

If you can’t find the files or folders you 
need

If you cannot locate the files or folders you want to 
restore by browsing through a recovery point, you can 
use the Norton Ghost Explore feature. This feature 
actually mounts a drive letter in a recovery point as if it 
were a working drive. You can then use the Windows 
Explorer search feature to search for the files you need. 
You can even drag and drop files to restore them.



Recovering files and folders
If you can’t find the files or folders you need

84

See “Advanced exploring of recovery points” on page 85.



Advanced exploring 
of recovery points 9
About advanced exploring of recovery 
points

Norton Ghost includes advanced features for exploring 
recovery points, including the ability to mount a drive 
letter contained in a recovery point. By mounting a 
recovery point drive, you can share the recovery point 
over a network, edit and save changes to files, and run 
programs that exist in the recovery point.

You can explore files in a recovery point by assigning it a 
drive letter that is visible from the Recovery Point 
Browser and Windows Explorer. You can perform a 
variety of tasks on the drive, such as run ScanDisk (or 
CHKDSK), perform a virus check using antivirus 
software such as Norton AntiVirus, copy folders or files 
to an alternate location, or simply view disk information 
about the drive such as used space and free space. You 
may also be able to run executable programs that exist 
within the mounted recovery point.

When a drive is mounted, you can set it up as a shared 
drive. Users on a network can connect to the shared drive 
and restore files and folders from within the recovery 
point.

You can mount one or more recovery points at a time. 
The drives remain mounted until you dismount them or 
restart the computer. Mounted drives do not take up 
extra hard disk space.
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All security on NTFS volumes remains intact when they 
are mounted.

It is not necessary to mount a drive to restore files or 
folders from within a recovery point.

w Any data written to a mounted recovery point, including 
creating, editing, or deleting files, is lost when it is 
dismounted.

Mounting a recovery point as a drive
You can mount a recovery point as a drive. You can also 
mount a drive in a recovery point so that it appears as a 
mounted drive on your computer.

For each drive included in the recovery point, a new 
mounted drive letter is created. For example, if your 
recovery point contains backups of drive C and D, two 
newly mounted drives appear (such as E and F). The 
mounted drives include the original drive labels of the 
drives that were backed up.

To mount recovery point as a drive

1 Start Norton Ghost and click Recovery. 

2 Click Explore Recovery Points (Advanced).

3 Select a recovery point from the list, and then click 
Explore.

4 To mount additional recovery points, repeat these 
steps.

Mounting a recovery point from Windows 
Explorer

When you mount a recovery point as a drive from within 
Windows Explorer, you can then use key Windows 
Explorer features to navigate the contents of the recovery 
point. 

You can search the contents of the recovery point. If you 
cannot remember where a particular file was originally 
stored, you can then use the Explorer search feature to 
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locate the file, just as you would locate a file on your hard 
drive. 

You can also drag and drop files to a location on your 
computer as a quick way of restoring files or folders.

To mount a recovery point from Windows Explorer

1 In Windows Explorer, navigate to a recovery point 
(located where you set up your default recovery point 
storage when you defined your backup).

2 Right-click the recovery point, and then click Mount.

3 In the Mount Recovery Point window, select the drive 
label you want mounted.

4 In the Drive letter drop-down list, select a letter that 
you want associated with the drive.

5 Click OK. 

6 To mount additional drives, repeat steps 1-5.
Mounted backup drives appear in both Recovery Point 
Browser and Windows Explorer.

Dismounting a recovery point drive
Restarting the computer will dismount all mounted 
recovery point drives in Windows Explorer and the 
Recovery Point Browser. You can also dismount them 
without restarting.

To dismount a recovery point in Windows Explorer

1 In Windows Explorer, navigate to the mounted 
recovery point.

2 Right-click the drive, and then click Dismount 
Recovery Point.

To dismount a recovery point in Recovery Point 
Browser

1 Close the Explore Recovery Points dialog box.

2 Click Yes when asked if you want to end exploring of 
all recovery points.
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Viewing properties of a drive within 
recovery point 

You can view the following drive properties of a recovery 
point:

To view the drive properties of a recovery point

1 In the tree panel of the Recovery Point Browser, 
double-click the recovery point that contains the 
desired drive.

2 Select a drive.

3 Do one of the following:
2 On the menu bar, click File > Properties.
2 Right-click the recovery point, and then click 

Properties.

Description A user-assigned comment associated with the drive.

Original drive 
letter

The original drive letter that was assigned to the drive.

Cluster size The cluster size (in bytes) used in a FAT, FAT32, or NTFS 
drive.

File system The file system type (for example, FAT, FAT32, or NTFS) used 
within the drive.

Primary/Logical The selected drive’s status as either Primary (primary 
partition) or Logical (logical partition).

Size The total size (in megabytes) of the drive. This total 
includes both used and free space.

Used space The amount of used space (in megabytes) within the 
drive.

Unused space The amount of free or unused space (in megabytes) within 
the drive.
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About Recovering a drive

You can restore all lost information to a secondary drive, 
which is a drive other than the primary drive where 
Windows is installed (typically C). 

For example, if your computer has a D drive and the data 
has been lost, you can use the Recover My Computer 
feature to restore drive D back to an earlier date and time 
before data was lost.

w If you cannot start Windows, you may need to recover 
your computer.

See “Recovering your computer” on page 93.

To recover a drive, you must have a current recovery 
point that includes the drive to be recovered. If you are 
not sure, you can use the Check Backup and Recovery 
Status feature.

See “Viewing the level of backup protection for each 
drive” on page 69.

w When you recover a drive, all current data on the drive 
being recovered is replaced by the data contained in the 
latest recovery point. This means that if you made 
changes on the drive after the latest recovery point was 
created, such as the creation of a new file, those changes 
will not be recovered.

To recover a drive

1 In the Recovery panel, click Recover My Computer.
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2 Select a recovery point, and then click Recover My 
Computer.

3 Do one of the following:

4 Click Next.

5 Either use the recovery point already selected, or click 
Browse to locate a different recovery point, and then 
click Next.
If you need to access recovery points on a network 
that requires user authentication, enter your user 
name and password, and then click Next.

6 Select the destination (the drive being restored), and 
then click Next.
If there is not enough free space to restore a recovery 
point, you can press Shift to select multiple, 
contiguous destinations that exist on the same hard 
disk.

7 If the recovery point is password-protected, type the 
password in the Password text box, and then click 
OK. 

To automatically 
detect where the 
drive should be 
restored

Click Express > OK > Yes.

To modify where 
and how the drive 
is restored

Click Custom > OK.
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See “Recovering 
your computer” on 
page 93.

8 Set options for how you want the restore to be 
performed. Your options are: 

Options Description

Verify 
recovery 
point before 
restore

Determines whether a recovery point 
is valid or corrupt before restoring it. 

Enabling this option will 
significantly increase the time 
required for the recovery to 
complete. However, it can ensure 
that the recovery point being 
restored is valid. 

Check for file 
system errors

Checks the restored drive for errors 
after restoring the recovery point.

Resize drive 
to fill 
unallocated 
space

Automatically expands the drive to 
occupy the destination drive’s 
remaining unallocated space.

Set drive 
active (for 
booting OS)

Makes the restored drive the active 
partition (the drive the computer 
starts from). 

Restore 
original disk 
signature

Restores the original physical disk 
signature of the hard drive.

This option is recommended for 
advanced users.

Partition type Select one of the following:

1 Primary partition: To restore as a 
primary partition

1 Logical partition: To restore as a 
logical partition inside an 
extended partition

Drive letter Select a drive letter you want 
assigned to the partition from the 
Drive letter drop-down list. 
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The actual options available are dependent on the 
restore destination you selected in the previous step.

9 Click Next to review the restore options you have 
selected.

10 Click Finish to restore the drive.
If the Wizard cannot lock the drive to perform the 
recovery under Windows, it will prompt you to insert 
the product CD and manually start the recovery 
environment so you can complete the recovery. When 
the recovery is finished, the computer is restarted 
automatically.
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When you can no longer start Windows, you can recover 
your computer using the Symantec recovery 
environment.

w If you can start Windows but you need to restore all data 
on a secondary drive that has been lost, such as drive D 
or E, for example, you can do so from within Windows. 
See the “Recovering a drive” chapter in the Norton Ghost 
User’s Guide.

The recovery environment makes restoring your 
computer possible under almost any computer disaster. 

Occasionally, a computer failure can leave the operating 
system intact but prevent you from restoring a recovery 
point after restarting. Or, a computer failure can leave 
the operating system inoperative, making a restoration 
seem impossible. 

For these types of situations, you can restore your 
computer using a recovery point from within the 
recovery environment (Symantec Recovery Disk).

In the recovery environment, you can run, among other 
tools, the Recover My Computer Wizard (to restore your 
computer) or the Recover My Files Wizard (to restore 
files or folders). 

After running the Recover My Computer Wizard, you can 
restart the computer into its previous, usable state.
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w If you purchased Norton Ghost pre-installed on your 
computer, some features in the recovery environment 
may or may not be included, depending on how the 
computer manufacturer chose to install Norton Ghost. 
Typically, the recovery environment has also been pre-
installed on your computer’s hard disk. It can then be 
started without the use of a CD and after restarting your 
computer. Typically, keyboard keys have been assigned 
for the purpose of starting the recovery environment. 
When restarting your computer, watch for instructions 
on your computer monitor, or refer to your 
manufacturer’s instructions. 

If you have been given a product CD, be sure to store it in 
a safe and secure place.

Starting your computer using the 
recovery environment

The Norton Ghost product CD is used both to install the 
product and to start a computer using the recovery 
environment, known as Symantec Recovery Disk. Be 
sure to store the CD in a safe place.

If you need to restore your computer, files, or folders 
using Symantec Recovery Disk (due to the inability of 
being able to start Windows normally due to lost 
hardware, data, or program files on a drive), you can use 
the product CD to start the computer using the recovery 
environment.

w The recovery environment requires a minimum of 256 
MB of RAM to run. If your computer’s video card is 
configured to share your computer’s RAM, you might 
need more than 256 MB of RAM to use the recovery 
environment.

To start your computer using the recovery 
environment

1 If you want to use a USB device while you are running 
the recovery environment, attach the device.
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2 Insert the product CD into the media drive of the 
computer. 
If you purchased Norton Ghost pre-installed on your 
computer from a computer manufacturer, the 
recovery environment is likely installed on your 
computer’s hard drive.

3 Restart the computer.
You may need to modify your system to make it 
startable from the CD.
If you cannot start the computer from the CD, you 
might need to configure your computer to do so. 
See “Getting your computer to start from the CD” on 
page 96.

4 As soon as you see the prompt "Press any key to boot 
from CD" appears, press a key to start the recovery 
environment. 

5 If you need to install storage drivers for the 
computer's hard disk subsystem, press F6 when 
prompted while starting the recovery environment.
If you cannot access the drive containing your 
recovery points, review related troubleshooting 
information.
See “I cannot access the local drive where my 
backups are saved”, and “I cannot access the network 
drive where my recovery points are saved” in the 
troubleshooting section of the Norton Ghost Help or 
the Norton Ghost User’s Guide.

6 Read the license agreement, and then click Accept.
If you decline, you cannot start the recovery 
environment and your computer will restart.

7 Click the time zone field at the bottom of the main 
window. 
In the Select Time Zone dialog box, select the time 
zone location you are in from the Time Zone drop-
down list, and then click OK. 
If you want to see accurate recovery point dates and 
times, you might need to set the correct time zone 
while in the recovery environment. 
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Getting your computer to start from the CD
To run Symantec Recovery Disk, you must be able to 
start your computer using the Norton Ghost product CD.

To start from the product CD

1 Turn on your computer. 

2 While the computer is starting, watch the bottom of 
the screen for a prompt that tells you how to access 
the BIOS. 
Generally, you will need to press Del, F1, F2, or F10. 

3 From the BIOS screen, choose the Boot menu. 

w The term boot refers to the location where software 
required to start a computer is stored. The Symantec 
Recovery Disk contains a simple version of the 
Windows operating system. By changing the boot 
sequence of your computer to your CD drive, the 
computer can then load this version of Windows. Boot 
is also used synonymously with start.

4 Change the CD or DVD drive to be the first bootable 
device in the list. 

5 Save the changes and exit the BIOS setup. 
When you start your computer with the product CD in 
the drive, you will see a prompt telling you to “press 
any key to boot from CD”. If you do not press a key, 
your computer will attempt to start from the next 
bootable device listed in the BIOS. There is only a 
short delay when the prompt to press a key is 
displayed, so you need to watch carefully as the 
computer starts. 

6 Press any key to start the recovery environment 
(Symantec Recovery Disk).

Preparing to recover your computer
Before starting the recovery process, you might want to 
scan your computer for viruses, a feature available from 
the Symantec recovery environment. You can also scan 
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your hard disk to check it for corrupted data or even 
surface damage.

1 Scanning for viruses

1 Checking your hard disk for errors

Scanning for viruses
If you suspect that your computer was damaged by a 
virus or other threat, you might want to scan for any 
viruses that might be the cause of your computer 
problems. 

To scan for viruses

1 On the Analyze panel, click Scan for Viruses.

2 Select one of the following:

For instructions on how to obtain the latest virus 
definitions, refer to the next topic.
See “Locating the latest virus definitions” on page 97. 

Locating the latest virus definitions

Although virus definitions are included on the product 
CD, you have a better chance of success when you use 
the newest virus definitions. The Update Locator locates 
virus definitions available from Symantec servers. 
However, you must run the Update Locator on a working 
computer that has Internet access.

To locate the latest virus definitions

1 Load the Norton Ghost product CD into the CD drive of 
a working computer that has Internet connectivity.

2 Browse to the root of the CD and double-click 
UPDILCTR.EXE.

Use the virus 
definitions on this 
CD

Uses the definitions included on 
your product CD.

Use Update Locator 
virus definitions 
folder

Select this option if you have 
downloaded the latest virus 
definitions to a disk.
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3 Click Find and retrieve virus definitions.
If more recent virus definitions are not found, you can 
still use Update Locator to scan your damaged 
computer, but it will not find viruses or threats that 
were released after the manufacture date of this CD.

4 When prompted, click OK.

5 Insert a floppy disk (or blank, writable CD or DVD) 
into the computer’s floppy disk drive (or CD/DVD 
recordable drive).

6 Locate the newly created Update Locator Virus 
Definitions folder on your computer’s desktop and 
copy it to the blank disk. 

7 Eject the disk, place it in a floppy drive (or CD/DVD 
drive) of the troubled computer and select it when 
prompted for virus definitions.

Checking your hard disk for errors
If you suspect that your hard disk is damaged, you can 
examine it for errors. 

To check your hard disk for errors

1 In the Analyze panel, click Check Hard Disks for 
Errors.

2 Select the drive you want to check.

3 Select the options you want.

Fix errors on disk Fixes errors on the selected 
disk. When not selected, 
displays errors found on the 
disk, but does not fix them.

Verbose output Displays the name of each file 
in every directory.

Find and correct 
bad sectors

Locates bad sectors and 
recovers readable information.

Skip check if drive 
is clean

Stops the check if no files exist 
on the drive.
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4 Click OK.

5 To save the report, click Save, specify a file name, and 
then click OK.

Recovering your computer
You can restore your computer (or any other drive or 
hard disk for which you have a recovery point) from 
within the recovery environment.

You can use the Recover My Computer Wizard from the 
Symantec Recovery Disk to return your computer to full 
functionality.

w All data on the drive being recovered is replaced by the 
data contained in the latest recovery point. This means 
that if you made changes on the drive after the latest 
recovery point was created, such as the creation of a new 
file, those changes will be lost. 

In such a case, you could restore the files and save them 
to another drive before running the Recover My 
Computer Wizard.

See “Recovering files and folders from the recovery 
environment” on page 104.

To recover your computer

1 Start the computer using the Symantec Recovery 
Disk.
See “Starting your computer using the recovery 
environment” on page 94.

2 From the Home panel, click Recover My Computer.
If the Symantec Recovery Disk cannot locate any 
recovery points, you are prompted to locate one. 
To locate a recovery point, Open another location, 
find a current recovery point, and then select it from 
the Select Recovery Point list.
When locating your recovery point storage during the 
recovery process, note that drive letters under the 
recovery environment may not match those in the 
Windows environment. For example, what was drive 
D under Windows might appear as drive E (or some 
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other name, such as the volume name assigned to the 
drive) while in the recovery environment.

3 Click Recover My Computer.

4 Select one of the following:

5 Review the recovery point details to make sure you 
are using the recovery point you intended to use, and 
then click Next.

6 Select the destination drive, or the drive you intend to 
recover.
When recovering your computer, this is the drive 
where Windows is installed. On most computer 
systems, this would be the C drive. However, while in 
Symantec Recovery Disk, drive letters and labels 
might not match what you would see if running in 
Windows. You might have to identify the correct drive 
based on its label, the name assigned to it, or by 
browsing files and folders in the recovery point.
See “Recovering files and folders from the recovery 
environment” on page 104.

Express 1 Select to automatically detect 
where the drive should be 
restored.

1 Check Reboot when finished if 
you want Symantec Recovery 
Disk to restart your computer 
when the recovery process is 
finished.

1 Then click OK > Yes to begin 
the recovery process.

Custom 1 Select to modify where and 
how the drive is restored.

1 Click OK.
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7 To free up disk space, select a drive, and then click 
Delete Drive. 
This will free space if a single volume space on the 
hard drive is not adequate. 
When you click Delete Drive, the drive is only 
marked for deletion. The actual deletion of the drive 
takes place after you click Finish in the wizard. 

8 If you change your mind before clicking Finish, go 
back to the Recovery Destination window, and then 
click Undo Delete to unmark the drive for deletion. 

9 Click Next. 

10 Select which options you want performed during the 
recovery process. Your options include: 

Verify 
recovery point 
before restore

Determines whether a recovery point 
is valid or corrupt before restoring it. 

Enabling this option will significantly 
increase the time required for the 
recovery to complete. However, it can 
also ensure that the recovery point 
being restored is valid. 

Check for file 
system errors 
after recovery

Check the restored drive for errors 
after restoring the recovery point.

Resize drive 
to fill 
unallocated 
space

Automatically expand the drive to 
occupy the destination drive’s 
remaining unallocated space.

Set drive 
active (for 
booting OS)

Makes the restored drive the active 
partition (the drive the computer 
starts from). 

When restoring a drive where 
Windows (your operating system) is 
installed, you should select this 
option.



Recovering your computer
Recovering your computer

102

Partition type Select one of the following:

1 Primary partition: To restore as a 
primary partition

1 Logical partition: To restore as a 
logical partition inside an 
extended partition

Restore 
original disk 
signature

Restores the original physical disk 
signature of the hard drive.

Disk signatures are included in 
Windows Server 2003, Windows 2000 
Advanced Server, and Windows NT 
Server 4.0 Enterprise Edition (SP3 and 
later) and are necessary before the 
hard drive can be used.

This option is recommended for 
advanced users and is available 
when restoring a whole drive only.
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The actual options that are available are dependent on 
the restore destination you selected in the previous 
step.

11 Click Next to review the restore options you have 
selected.

12 Check Reboot when finished if you want the 
computer restarted for you automatically when the 
recovery process finishes.

13 Click Finish > Yes to restore the drive.

Restore 
Master Boot 
Record (MBR)

Restores the master boot record. The 
master boot record is contained in 
the first sector of the first physical 
hard drive. The MBR consists of a 
master boot program and a partition 
table that describes the disk 
partitions. The master boot program 
looks at the partition table to see 
which primary partition is active. It 
then starts the boot program from 
the boot sector of the active 
partition. 

This option is recommended for 
advanced users and is available only 
when restoring a whole drive under 
the recovery environment. 

Preserve 
domain trust 
token on 
destination

Preserves the token used to 
authenticate a user/computer on a 
domain. This is a method for making 
sure that a recovered computer is 
recognized by a network domain 
after it is recovered.



Recovering your computer
Recovering files and folders from the recovery environment

104

Recovering files and folders from the 
recovery environment

You can start your computer using the Symantec 
Recovery Disk and restore files and folders from within a 
recovery point.

When you are running the recovery environment, there 
are several support utilities available that you can run to 
troubleshoot networking or hardware issues you may 
encounter. For example, you can ping a computer, renew 
IP addresses, or get information about a hard disk 
partition table. 

To restore files and folders using the recovery 
environment

1 Start the computer using the recovery environment.
See “Starting your computer using the recovery 
environment” on page 94.

2 Click Recover My Files. 

3 If the Symantec Recovery Disk cannot locate any 
recovery points, you are prompted to locate one. 
2 Click OK > Open another location.
2 Browse to an alternate folder where current 

recovery points are stored.
2 Click OK, select a recovery point from the 

resulting list, and click Browse Contents. 

w If you are attempting to restore files or folders from a 
network location and you are having trouble, make 
sure you type the name of the computer and share 
that holds your recovery points, in the File name text 
box. For example, \\computer_name\share_name.you 
might have to modify some settings. 

If you are still having problems, see “Using the 
networking tools in the recovery environment” on 
page 106.

4 In the tree view panel of the Recovery Point Browser, 
double-click the drive containing the files or folders 
you want to restore to expand it.
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5 In the content panel of the Recovery Point Browser, do 
the following to select the files or folders you want to 
restore.

6 Click Recover Files.
Where possible, the Recover Items dialog box will 
automatically fill in the Restore to this folder text box 
with the original path where the files originated. 
If the original location does not include a drive letter 
(because the drive was hidden when you created the 
recovery point), you must enter a drive letter for the 
drive before you can restore any files or folders. 

7 If the original path is unknown, or you want to restore 
the selected files to a different location, click Browse 
to locate the destination. 

8 Click Recover to restore the files. 

Exploring your computer
You can explore the files and folders on your computer 
from within the recovery environment using the Explore 
My Computer feature.

This feature actually uses the Recovery Point Browser as 
a tool for exploring your computer and functions 
similarly to Windows Explorer in that you can browse the 
file structure of any drive attached to your computer from 
within the recovery environment.

To explore your computer

4 From the Analyze panel, click Explore My 
Computer.

To select all items Press Ctrl+A

To select a group 
of files that are 
next to each other

Select the top file, press Shift, 
and then select the last file in the 
list

To select a group 
of files that are not 
next to each other

Press Ctrl while selecting the 
files
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Using the networking tools in the 
recovery environment

If you store your recovery points on a network, you will 
need access to the network to restore your computer, or 
files and folders from the recovery environment. 

w Additional computer memory might be required when 
recovering your computer across a network.

Starting networking services
If you need to start networking services, you can do so 
manually.

To start networking services

4 On the Network panel, click Start My Networking 
Services.
To verify connection to the network, you can map a 
network drive. See “Mapping a network drive in the 
recovery environment” on page 108.

Using the pcAnywhere Thin Host for a remote 
recovery

Using the Symantec Recovery Disk, you can host a 
remote control session by starting pcAnywhere Thin 
Host. Once started, the thin host waits for a connection 
that can be used to remotely manage a recovery or 
perform other tasks in the recovery environment.

To connect to the thin host, you must use Symantec 
pcAnywhere on a remote computer.

The pcAnywhere Thin Host contains the minimum 
settings needed to support a single-use remote control 
session. The thin host requires an IP address for hosting 
a remote control session.

w A thin host cannot be deployed to the recovery 
environment. The thin host can only be started from 
Symantec Recovery Disk to host a remote control 
session. The thin host in Symantec Recovery Disk does 
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not support file transfers and cannot be used to add 
drivers for network or storage devices.

To start the pcAnywhere Thin Host

4 In the recovery environment main window, go to the 
Home panel, and then click Start the pcAnywhere 
Thin Host.
If not started, the Networking services are started.
The thin host establishes a connection.

Remotely connecting to the thin host

Symantec pcAnywhere can be used on a computer to 
remotely connect to a computer that has already started 
using the recovery environment and that has started the 
pcAnywhere Thin Host. Once connected, the client 
computer can remotely manage a recovery or perform 
other tasks supported in the recovery environment.

w The client computer cannot transfer files or add 
additional drivers for network or storage devices on the 
computer running the thin host.

To remotely connect to the thin host

1 Ensure that the computer to be remotely managed 
(the host) has been started using Symantec Recovery 
Disk and that the pcAnywhere Thin Host has been 
started and is waiting.

2 Obtain the IP address of the thin host computer.

3 On the client computer, in Symantec pcAnywhere, 
use the Remote Setup Wizard to configure the remote 
control session.
2 Specify a TCP/IP connection type.
2 Specify the IP address of the host computer.
2 Choose to automatically login to the host on 

connection.
2 Type the following login name: 

symantec
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2 Type the following password:
recover

The thin host shuts down when there is an attempt to 
connect using any incorrect configuration settings.
The thin host does not support encryption.
To prevent unauthorized users from tampering with 
your settings or launching a session without your 
permission, set a password for your remote 
connection item using the Protect Item properties 
page in Symantec pcAnywhere.

4 Start the remote control session.
If the connection attempt is unsuccessful, the thin 
host must be restarted on the host computer before 
making another attempt to connect.

5 Remotely perform necessary tasks on the host 
computer.
The remote control session ends when the thin host is 
closed, the thin host computer is restarted, or when 
the remote control session is ended.
After the host computer has started Windows, the 
client computer can deploy and connect a thin host on 
the computer to verify the success of tasks that were 
performed while using the recovery environment.

Mapping a network drive in the recovery 
environment

The following information applies only if you started 
networking services after starting the recovery 
environment.

If there is no DHCP server (or the DHCP server is down), 
you must enter a static IP address and a subnet mask 
address for the computer on which you are running 
Symantec Recovery Disk. 

See “Configuring network connection settings” on 
page 109.

After the static IP address and subnet mask address are 
correctly entered, you will be able to enter the recovery 
environment. However, because there is no way to 
resolve computer names, when you run the Recover My 
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Computer Wizard or the Recovery Point Browser, you 
will only be able to browse the network using IP 
addresses to locate a recovery point. To resolve this 
issue, you can map a network drive.

To map a network drive in the recovery environment

1 In the recovery environment main window, click the 
Network panel, and then click Map a network 
drive.

2 Map a network drive using a UNC path of the 
computer where the recovery point is located. 
For example: \\computer_name\share_name or 
\\IP_address\share_name 
You will now be able to browse to that drive mapping 
and select a recovery point that you want to restore. 

Configuring network connection settings
You can access the Network Configuration window to 
configure basic network settings while running in the 
recovery environment. 

To open the Network Configuration window

1 In the recovery environment main window, click the 
Network panel, and then click Configure Network 
Connection Settings.

2 If you are prompted to start networking services, click 
Yes.

Getting a static IP address

If you are trying to restore a recovery point that is located 
on a network drive/share, but you are unable to map a 
drive or browse to the drive/share on the network 
(usually caused by the lack of an available DHCP 
service), you can assign a unique static IP address to the 
computer that is running the recovery environment. You 
can then map to the network drive/share. 

To get a static IP address

1 In the list box of the Network Configuration window, 
click IP Address 1.



Recovering your computer
Using the networking tools in the recovery environment

110

2 In the Enter Adapter Address dialog, specify a unique 
IP address and subnet mask for the computer you are 
restoring. 
Be sure that the subnet mask matches the subnet 
mask of the network segment. 

3 Click OK, and then click Close to return to the 
recovery environment main menu. 

4 From the Network panel, click Ping a Remote 
Computer.

5 Specify the address of a computer you want to ping on 
the network segment using one of the following 
address methods. (Usually it is the computer that 
holds the recovery points you need to use.)

6 Click OK.
If you specified a computer name or computer name 
and domain as the address method, make note of the 
IP address that is returned from the computer you are 
pinging. 
If communication to the storage computer is 
operating as expected, you can use the Map Network 
Drive utility to map a drive to the recovery point 
location. 

Computer name Specify a computer name if you 
use the domain or workgroup 
to resolve computer names.

For example, ComputerA

Computer name 
and domain

Specify a computer name and 
domain if you are using an 
Active Directory domain to 
resolve computer names.

For example, 
computera.domain.com

IP address Specify an IP address if there is 
no computer name resolution 
available on the segment.

For example, 127.167.68.255
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Getting a static IP address if the ping is unsuccessful

If you ping an address and the address does not respond, 
you can use the ipconfig /all command to find out the 
correct IP address.

To get an IP address if the ping is unsuccessful

1 On the computer that holds the recovery point you are 
wanting to restore, at a DOS prompt, type ipconfig /
all, and then press Enter.

2 Write down the IP address that is displayed.

3 Return to the computer that is running the recovery 
environment and run the utility Ping Remote 
Computer using the IP address you wrote down. 

Mapping a network drive

You can map a drive from within the recovery 
environment. 

To map a network drive

1 In the recovery environment main window, click the 
Network panel, and then click Map a network 
drive.

2 In the Drive drop-down list, select a drive letter. 

3 In the Folder text box, type the IP address of the 
storage computer and the share where the recovery 
point is located. 
For example: \\IP_address\share_name\

4 Click Connect using a different user name. 

5 In the User name box, type the IP address and 
username. 
For example: IP_address\user_name

6 In the Password text box, type the username and 
password. 

7 Click OK. 
You should now have a drive mapped to the recovery 
point location on the storage computer.



Recovering your computer
Viewing properties of recovery points and drives

112

Viewing properties of recovery points 
and drives

You can view the properties of recovery points and the 
drives contained in them.

1 Viewing properties of a recovery point

1 Viewing properties of a drive within a recovery point

Viewing properties of a recovery point
You can view various properties of a recovery point using 
the Recovery Point Browser. The following properties are 
available for viewing:

To view the properties of a recovery point

1 In the tree panel of the Recovery Point Browser, select 
the desired recovery point. 

2 Do one of the following:

Description A user-assigned comment associated with the recovery point

Size The total size (in megabytes) of the recovery point

Created The date and time that the recovery point file was created

Compression The compression level used in the recovery point

Spanned Whether the entire recovery point file is spanned over several 
files

Password 
protected

The password protection status of the selected drive

Encryption The encryption strength used with the recovery point

Version The version number of the recovery point

Computer 
name

The name of the computer on which the recovery point was 
created

Created by Identifies which version of Norton Ghost created the recovery 
point
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2 On the File menu, click Properties.
2 Right-click the recovery point, and then click 

Properties. 

Viewing properties of a drive within a recovery 
point

You can view the following properties of a drive within a 
recovery point:

To view the drive properties of a recovery point

1 In the tree panel of the Recovery Point Browser, 
double-click the recovery point that contains the 
desired drive.

2 Select a drive.

3 Do one of the following:
2 On the menu bar, click File > Properties.
2 Right-click the recovery point, and then click 

Properties.

Description A user-assigned comment associated with the drive

Original drive 
letter

The original drive letter that was assigned to the drive

Cluster size The cluster size (in bytes) used in a FAT, FAT32, or NTFS drive

File system The file system type (for example, FAT, FAT32, or NTFS) used 
within the drive

Primary/Logical The selected drive’s drive status as either Primary (primary 
partition) or Logical (logical partition)

Size The total size (in megabytes) of the drive

This total includes both used and free space

Used space The amount of used space (in megabytes) within the drive

Unused space The amount of free or unused space (in megabytes) within 
the drive
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About the Support Utilities
When you are running in the recovery environment, 
there are several support utilities available (from the 
Utilities panel in the main window of the recovery 
environment) that Symantec Technical Support might 
have you use to troubleshoot hardware issues you might 
encounter. 

You might be required to supply information generated 
by these utilities if you call Symantec Technical Support 
for help resolving problems.

w You should only use these tools as directed by Symantec 
Technical Support.
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About copying drives

You can copy the contents of one hard disk to another. 
You can also copy your operating system, applications, 
and data to a new hard disk. If the hard disk you are 
copying contains more than one partition, you must copy 
the partitions one at a time to the new hard disk.

You can use the Copy My Hard Drive feature when you 
upgrade to a larger hard disk or when you add a second 
hard disk and keep the original. You should not use this 
feature to set up a hard disk that will be used in another 
computer.

w If you are using a trial version of Norton Ghost, the Copy 
My Hard Drive feature is not enabled. To use this feature, 
you must upgrade to a licensed version of Norton Ghost 
10.

Before using the Copy My Hard Drive 
feature 

Before you can copy drives, you must have the hardware 
configured correctly.

To install and configure a hard disk

1 Prepare the computer. Get the manufacturer’s 
directions for installing the drive. Shut down the 
computer, and disconnect the power cord. Discharge 
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electricity by touching a grounded metal object. 
Remove the computer cover. 

2 Change the hard disk jumper settings to make the 
new hard disk the slave drive, or connect it as the 
slave drive if you are using cable select instead of 
jumper settings to determine the master and slave 
drives. 

3 Attach the new hard disk. Connect the cable so that 
the colored stripe on the edge lines up with the I/O 
pins on the motherboard. The motherboard is marked 
Pin1 or 1 where the colored stripe should go. Next, 
connect the other end of the cable to the back of the 
hard disk, again matching the striped edge with the I/



Copying drives
Before using the Copy My Hard Drive feature

117

O pin position on the drive itself. The I/O pin is 
usually on the side closest to the power supply. 

4 Attach the power connector to the new hard disk. 
There is only one way to connect the power cable—do 
not force it. Make sure the angled edge of the plastic 
connector lines up with the angled edge of the pin 
socket. 
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5 Anchor the drive in the bay area according to the 
manufacturer’s instructions for the computer or the 
computer bay requirements. 

6 Change the BIOS to recognize the new hard disk. To 
change the BIOS settings, watch the bottom of the 
screen while your computer is starting up. Press Del, 
F1, F2, or F10 according to the legend that appears. 
Select Auto Detect for both the master and slave 
drives. Save the BIOS changes, and then exit. Your 
computer will restart automatically. 

Copying one hard disk to another hard 
disk

When your new hard disk is installed, you are ready to 
copy your old hard disk to the new one. The new hard 
disk does not need to be formatted. 

If the hard disk you are copying contains more than one 
partition (for example, a C:\ drive, a D:\drive, an E:\ drive, 
and so forth), you must copy each partition, one at a time, 
to the new hard disk.

If the power or other hardware fails when you are 
copying data, no data is lost from the source drive. 
Should the power or other hardware fail, just start the 
process again after the failure is resolved.
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To copy one hard disk to another

1 On the Backup panel, click Copy My Hard Drive. 

2 Follow the instructions in the Wizard to copy the 
drive. 
The Wizard will guide you through selecting the right 
drive to copy, the destination drive, and the options 
for copying the data from one drive to another. 

About Copy My Hard Drive Wizard options
As part of copying one hard disk to another hard disk, 
your options are as follows:

Check source for file 
system errors

Checks the source (original) 
drive for errors before copying 
it.

Check destination for 
file system errors

Checks the destination (new) 
drive for errors after copying 
the drive.

Resize drive to fill 
unallocated space

Automatically expands the 
drive to occupy the 
destination drive’s remaining 
unallocated space.
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Set drive active (for 
starting OS)

Makes the destination drive 
the active partition (the drive 
the computer starts from). 
Only one drive can be active at 
a time. To start the computer, 
it must be on the first drive, 
and it must contain an 
operating system. When the 
computer starts, it reads the 
partition table of the first 
drive to find out which drive is 
active, and then starts from 
that location. If the drive is 
not bootable or you are not 
certain that it is, have a boot 
disk ready.

Set drive active is valid for 
basic disks only (not dynamic 
disks).

Disable SmartSector 
copying

Symantec’s SmartSector® 
technology speeds up the 
copying process by only 
copying clusters and sectors 
that contain data. However, in 
some cases, such as high-
security environments, it may 
be desirable to copy all 
clusters and sectors in their 
original layout, whether or 
not they contain data.

Using this option increases the 
time required for the copy 
because all cluters and 
sectors, regardless of whether 
or not they contain data, are 
copied.



Copying drives
Copying one hard disk to another hard disk

121

Ignore bad sectors 
during copy

Copy the drive even if there 
are errors on the disk.

(However, if there are too 
many errors that cannot be 
ignored, Ghost will not 
perform the copy.)

Destination partition 
type

Lets you specify the 
destination drive as either a 
primary partition or a logical 
partition inside an extended 
partition. 

Drive letter Select a drive letter you want 
assigned to the partition from 
the Drive letter drop-down 
list.

Copy MBR Copy the master boot record 
from the source drive to the 
destination drive. Select this 
option if you are copying the 
C:\ drive to a new, empty hard 
disk. You should not select 
this option if you are copying 
a drive to another space on 
the same hard disk as a 
backup or if you are copying 
the drive to a hard disk with 
existing partitions that you 
will not be replacing. 
Additionally, if you are 
copying multiple drives to a 
new, empty hard disk, you 
only need to select this option 
once.
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Restarting the computer after copying 
drives

After you have copied the old hard disk to the new hard 
disk, do one of the following:

1 Either remove the old hard disk or keep it as a slave 
drive.

See “Before using 
the Copy My Hard 
Drive feature” on 
page 115.

1 Change jumper settings to make the new hard disk 
the master drive before restarting the computer. 
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About troubleshooting Norton Ghost

If you need more information about resolving a problem, 
please check the Symantec Web site.

You should also see the Readme.txt file on the product 
CD which also includes valuable troubleshooting 
information beyond what is included in this section. 

See “Exploring the 
Symantec service 
and support Web 
site” on page 123.

Exploring the Symantec service and 
support Web site

On the Symantec service and support Web site, you can 
find the latest protection and program updates, patches, 
online tutorials, Knowledge Base articles, error codes, 
and virus removal tools. 

To explore the Symantec service and support Web site

1 On the Internet, go to www.symantec.com/techsupp.

2 On the service and support Web page, under the 
heading home & home office/small business, click 
Continue.

3 Follow the links to the information that you want.
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Searching the Web site
If you cannot find what you are looking for using the 
links on the introduction page, try searching the 
Symantec Web site.

To search the Symantec service and support Web site

1 At the top of any Symantec Web site page, click 
Search.

2 On the search page, type a word or phrase that best 
represents the information for which you are looking. 
Use the following guidelines when searching the 
Symantec Web site:
2 Type a single word in lowercase letters to find all 

occurrences of the word, including partial 
matches. For example, type “install” to find 
articles that include the word install, installation, 
installing, and so on.

2 Type multiple words to find all occurrences of any 
of the words. For example, type “virus definitions” 
to find articles that include virus or definitions or 
both.

2 Type a phrase enclosed in quotation marks to find 
articles that include this exact phrase. 

2 Type a plus (+) sign in front of all of the search 
terms to retrieve documents containing all of the 
words. For example, +Internet +Security finds 
articles containing both words. 

2 For an exact match, type the search words in 
uppercase letters. 

2 To search for multiple phrases, enclose each 
phrase in quotation marks, and use commas to 
separate the phrases. For example, “purchase 
product”, “MAC”, “Norton Ghost” searches for all 
three phrases, and finds all articles that include 
any of these phrases.

3 Select the area of the Web site that you want to 
search.

4 Click Search.
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Troubleshooting Norton Ghost
Check this section for possible solutions to issues that 
might arise with Norton Ghost. Key troubleshooting 
areas include the following:

1 Troubleshooting installation

1 Troubleshooting recovery points

1 Troubleshooting scheduled backups

1 Troubleshooting restoring recovery points from 
Windows

1 Troubleshooting the recovery environment

Troubleshooting installation
Following are some of the most common installation 
problems:

1 I don’t know the system information that I’m required 
to enter

1 Drive letter changes

1 Which version of Microsoft .NET Framework do I 
install

I don’t know the system information that I’m required to 
enter

You can get system information directly from Windows. 
This information can be used to specify an IP address, 
drivers, and so forth when installing the Symantec 
product or setting up the recovery environment.

To get system information from Windows

4 On the Windows taskbar, click Start > Programs > 
Accessories > System Tools > System 
Information. 
Use the tree panel area to select the information 
group you want to view or print.
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Drive letter changes

If the drive letter of the CD drive has changed since you 
installed the product, you will get an error message (the 
MSI file cannot be found) when you run the “Repair” or 
“Modify” installation option from the Norton Ghost CD. 
This error typically occurs if you are adding or removing 
external devices to a desktop PC or internal devices to a 
laptop.

To avoid this issue, make sure that Windows “sees” the 
CD drive as the same drive letter as when Norton Ghost 
was first installed.

Which version of Microsoft .NET Framework do I install

If you have Microsoft .NET Framework 1.1 already 
installed, version 1.1 will not be installed from the 
Norton Ghost CD.

Troubleshooting recovery points
Following are some of the most common issues when 
trying to create recovery points:

1 Burning recovery points to a CD or DVD

1 Support for CD/DVD burners

1 Support for DVD-ROM drives

1 About Hibernate.sys and pagefile.sys files

Burning recovery points to a CD or DVD

Following are the most common issues when trying to 
burn recovery points to a CD or DVD:

1 Difficulties while recovery points are being burned to 
CD might be resolved by downloading the latest CD or 
DVD drivers and firmware updates from the 
manufacturer of your CD or DVD writer. 
When you have completed the update, be sure you 
turn off the power to the computer (if your CD/DVD 
burner is internal), then turn the power back on. This 
will ensure that the computer recognizes the drive. If 
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your CD/DVD burner is external, unplug the power 
source to the burner, and then plug it back in.

1 If you create a recovery point of two drives and the 
first recovery point fills one and a half CDs, you will 
be prompted to insert new media before the second 
drive is backed up. It helps to think of the two drives 
as two separate backup sets. This process makes it 
easier to restore recovery points from removable 
media later. 

Support for CD/DVD burners

Check the Symantec Web site to make sure that your CD/
DVD burner is supported:

http://service1.symantec.com/SUPPORT/
powerquest.nsf/docid/2004030176699562.

Supported burners allow variable packet writing, a 
necessary feature if you are writing a recovery point to 
CD or DVD. Most burners manufactured since 1998 
support variable packet writing. If your burner is not 
listed, you should check your burner's documentation to 
see if variable packet writing is supported before you 
attempt to write recovery points to it.

Support for DVD-ROM drives

Some DVD-ROM drives cannot play DVD+R media. If you 
plan to run a backup and store recovery points on DVD+R 
media and later restore from a DVD-ROM drive, you 
should check the drive compatibility list at the following 
URL:

http://www.dvdplusrw.org/

About Hibernate.sys and pagefile.sys files

The hibernate.sys and pagefile.sys files are intentionally 
excluded from backups. These files contain temporary 
files that can take up a large amount of disk space. They 
are not needed and there will be no negative impact on 
your computer system after a complete system recovery. 

http://service1.symantec.com/SUPPORT/powerquest.nsf/docid/2004030176699562
http://service1.symantec.com/SUPPORT/powerquest.nsf/docid/2004030176699562
http://www.dvdplusrw.org/
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Even though these files appear in recovery points, they 
are only placeholders.

Troubleshooting scheduled backups
Following are some of the most common issues that 
occurr while scheduling backups:

1 Recovery points are no longer being created

1 Checking the status of the agent

1 I want to test the scheduling of my backups

1 I deleted a drive and now I get backup errors

Recovery points are no longer being created

When you define a backup, you can specify the number 
of recovery points you want to save on the hard disk 
before they are rotated out and deleted. When you use 
this option you must also make sure that you have 
enough hard disk space to accommodate the number of 
recovery points you specify, plus one additional recovery 
point. 

If you run out of hard disk space before the number of 
specified recovery points is reached, the recurring 
recovery point process will no longer function and a 
current recovery point will not be created. 

w You can configure Norton Ghost to notify you when a 
specified amount of disk space has been used up. You 
can then remove old recovery points using the Clean Up 
feature. 

See “Optimizing recovery point storage” on page 73.

The solution is to either reduce the number of recurring 
recovery points you are creating, or increase the amount 
of space necessary to maintain the number of recovery 
points you specify.

If this does not solve the issue, you should review the 
events log for clues as to what else might be happening. 
See “Verifying that a backup completed” on page 66.
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Checking the status of the agent

If you have problems with the agent, you should check its 
status.

To check the status of the agent

1 On the Windows taskbar, click Start > Run.

2 In the Open text box, type services.msc.

3 Click OK.

4 In the Name column, select Norton Ghost.
The Status column for Norton Ghost (you may need to 
scroll to the right to see the column) should have 
“Started” listed.

5 Do one of the following:
2 To stop the service, in the Name column, right-

click Norton Ghost, then click Stop.
2 To start the service, in the Name column, right-

click Norton Ghost, then click Start.

I want to test the scheduling of my backups

To test the scheduling of your backups, you can stop the 
Norton Ghost agent service in the Microsoft Services 
console (SERVICES.MSC), change the date forward on 
the computer to a time when a scheduled backup should 
occur, and then restart the Norton Ghost service. If the 
date is changed while the service is running, the change 
will not be noticed by the Norton Ghost service.

I deleted a drive and now I get backup errors

When a drive is deleted, Norton Ghost should detect that 
the drive is no longer available and remove the deleted 
drive from any defined backups that include the deleted 
drive. 

However, if you delete a drive, you should remove the 
drive from all backups associated with it to avoid any 
errors.
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Troubleshooting restoring recovery points from 
Windows

Check here for suggestions to help resolve problems that 
are encountered while restoring recovery points from 
Windows.

1 Restore from a recovery point that is spanned

1 Restore a system drive

Restore from a recovery point that is spanned

Following are the most common issues when trying to 
restore from a recovery point that has been spanned 
across multiple CDs or DVDs: 

1 When you restore a system drive under Windows 
from Norton Ghost and the recovery point is on 
multiple CDs, Norton Ghost will not prompt correctly 
for the next media. To avoid this problem, restore the 
backup manually from the System Restore Wizard in 
the recovery environment.

1 When you are restoring from CD, you are prompted to 
insert the first CD, followed by the last CD, the first 
CD, the last CD, then the first CD again. Then the 
restore begins and prompts you for the media in 
sequence. After restoring a recovery point, you will be 
prompted again to insert the first CD one more time. 
For example, if you had a recovery point that spanned 
across five CDs, the order you would insert the CDs 
would be as follows: 1-5-1-5-1-2-3-4-5-1.

Restore a system drive

Following are the most common issues when trying to 
restore a system drive (typically, drive C):

1 If you begin restoring a backup of a system drive 
under Windows and encounter an error, you will have 
to start the recovery environment and run the 
Recover My Computer Wizard to manually restore the 
backup.

1 When you restore a system drive under Windows, the 
restore may not complete successfully if the recovery 



Troubleshooting Norton Ghost
Troubleshooting Norton Ghost

131

environment assigns different letters to drives other 
than what was assigned under Windows. This 
discrepancy is sometimes caused by USB and 
FireWire devices or CD devices, or if you have 
manually changed drive letter assignments. (Under 
Windows fixed drives are assigned first; under the 
recovery environment, removable drives are assigned 
first.) The work-around is to restore the backup 
manually from the recovery environment using the 
Recover My Computer Wizard.

Troubleshooting the recovery environment
Check here for suggestions to help resolve problems that 
you might encounter while running Symantec Recovery 
Disk.

You should also see the Readme.txt file on the product 
CD, which includes valuable troubleshooting information 
in addition to what is included in this section.

1 Cannot start the computer from the CD

1 Cannot access the local drive where my backups are 
saved

1 Cannot access the network drive where recovery 
points are saved

1 Supported storage devices and NIC drivers

1 My recovery point is on CD but I can’t use the drive 
because the Norton Ghost CD is running the recovery 
environment

1 Warning appears indicating that Windows might not 
run correctly due to insufficient memory

Cannot start the computer from the CD

To run the recovery environment, you must be able to 
start your computer from the Norton Ghost CD.

To start your computer using the product CD

1 Turn on your computer.

2 While the computer is starting, watch for a prompt 
that tells you how to access the BIOS. Generally, you 
will need to press <Del>, <F1>, <F2>, or <F10>.
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3 From the BIOS screen, choose the Boot menu.

w The term boot refers to the location where software 
required to start a computer is stored. The Symantec 
Recovery Disk contains a simple version of the 
Windows operating system. By changing the boot 
sequence of your computer to your CD drive, the 
computer can then load this version of Windows. Boot 
is also used synonymously with start.

4 Change the CD or DVD drive to be the first bootable 
device in the list.

See “Starting your 
computer using the 
recovery 
environment” on 
page 94.

5 Save the changes and exit the BIOS setup. 
When you start your computer with the product CD in 
the drive, you will see a prompt telling you to “press 
any key to boot from CD”. If you do not press a key, 
your computer will attempt to start from the next 
bootable device listed in the BIOS. There is only a 
short delay when the prompt to press a key is 
displayed, so you need to watch carefully as the 
computer starts. 

6 Press a key, and the recovery environment will start. 

Cannot access the local drive where my backups are saved 

You may need to load drivers for the storage device 
where your backups are saved as part of starting the 
recovery environment.

To access the local drive

1 Start your computer using the Norton Ghost CD.

See “Supported 
storage devices 
and NIC drivers” on 
page 133.

2 When you see the prompt “Press any key to boot from 
CD”, immediately press F6.
If you press a different key, you will not have an 
opportunity to load special drivers.
By pressing F6, you can add storage drivers for most 
SCSI devices listed at:
www.microsoft.com/windows/catalog. 

3 Press S when prompted to specify additional SCSI 
adapters, CD drives, or special controllers for use with 
Windows, including those for which you have a device 

http://www.microsoft.com/windows/catalog
http://www.microsoft.com/windows/catalog
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support disk from a mass storage device 
manufacturer.
If you do not have the drivers available from the 
device manufacturer and they are not included as part 
of the recovery environment, you will not be able to 
use that drive. 

Cannot access the network drive where recovery points are 
saved

See “Supported 
storage devices 
and NIC drivers” on 
page 133.

The system where you are running the recovery 
environment may use a NIC driver that is not included as 
part of the recovery environment. Contact Symantec 
services and support if your NIC is not detected by the 
recovery environment.

Supported storage devices and NIC drivers

For a list of storage devices and NIC drivers that are 
supported by the recovery environment, please see 
www.symantec.com.

See “Starting your 
computer using the 
recovery 
environment” on 
page 94.

If your storage device is not listed, you can press F6 
when starting a computer using the recovery 
environment and manually load the necessary drivers.

If your NIC card is not listed and the recovery 
environment does not detect the driver, contact 
Symantec technical support. 

See “Service and support solutions” on page 149.

My recovery point is on CD but I can’t use the drive because 
the Norton Ghost CD is running the recovery environment

When you restore a backup from a CD or DVD from 
within the recovery environment and you only have one 
CD or DVD drive, you must leave the product CD in that 
drive until after you have clicked Browse to locate the 
backup. After the Open dialog box has displayed, you can 
remove the Norton Ghost CD or the Symantec Recovery 
Disk CD and insert the media that contains the backup.
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If you remove the product CD before clicking Browse, the 
recovery environment will exit back to the recovery 
environment main window.

Warning appears indicating that Windows might not run 
correctly due to insufficient memory

The recovery environment requires a minimum of 256 
MB of RAM to run. If your computer’s video card is 
configured to share your computer’s RAM, you might 
need more than 256 MB of RAM to use the recovery 
environment.

If you are not sure, you can continue. If you have 
difficulties using the recovery environment, you might 
need to upgrade your computer’s memory.

Recovery Point Browser error messages
Check here for suggestions to help resolve error 
messages that are encountered while running the 
Recovery Point Browser.

1 Cannot initialize COM library

1 Cannot allocate Norton Ghost mount manager 
instance

1 Cannot retrieve drive information

1 Cannot dismount drive. Please verify the drive is not 
locked by another process

Cannot initialize COM library
The product was unable to initialize the COM subsystem. 
This can be caused by insufficient resources or corrupt 
DLLs. Restart the computer and try to free system 
resources. 

Cannot allocate Norton Ghost mount manager 
instance

The product was unable to allocate resources for the 
Symantec mount manager. This error is usually reported 
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when the product is partially installed or some of the 
product’s COM objects are missing or incorrectly 
registered. To correct this condition, reinstall the 
product. 

Cannot retrieve drive information
The Symantec mount manager did not recognize the 
drive as a mounted recovery point. This error is most 
commonly reported when another process is attempting 
to dismount the drive. The error may also occur if the 
drive is corrupt. Close all Symantec products, and then 
retry the dismount operation. If the problem persists, 
restart the computer to allow Windows to re-enumerate 
all mounted drives. 

Cannot dismount drive. Please verify the drive is 
not locked by another process 

The Symantec mount manager was unable to dismount 
the drive. To resolve the error, make sure that there are 
no open files on the drive and that the drive is not locked 
by another application.

General error messages
Following is a list of the most common, general error 
messages: 

1 E0710007

1 E0B000C

1 E0BB0004

1 E0BB001B

1 E0BB0097

1 E0BB0147

1 E0BC000A

1 E7C3000F

1 E7D1001F

1 E926001F

1 EA39070A
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1 EA390712

1 EBAB001A

1 EC8A0001:The engine has not been initialized

1 EC8F0007

1 EC8F000C

1 EC950001

1 Error: The object invoked has disconnected from its 
clients

1 Catastrophic error

1 WinBOM error when starting the recovery 
environment

1 The month and year are reversed on some 
international computers

If you don’t see an error message here that matches the 
error message you are seeing, please visit the Symantec 
technical support Web site.

See “Service and support solutions” on page 149.

E0710007
Cannot create a virtual volume image.

If the error continues, run the recovery environment 
support utilities Display SME Disk Information and View 
Partition Information, obtain system information, then 
contact technical support. Additional log files, such as.txt 
files from the Agent folder, may also be needed.

E0B000C
This error may also display one of the following:

1 Object BasicDisk SME~Computer~BgM896453 was 
in the saved state but is not in the current state.

1 Object MediaCommon:Sme~computer 
~Pd1~M896453 was in the saved state but is not in 
the state.

These two error messages could be caused by changes to 
the serial number. They could also be caused by the drive 
information being reported differently.
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If the restore was initially set up in Windows, but the 
entire system was restarted with the product CD, try 
going through the Recover My Computer Wizard in the 
recovery environment on the product CD. There could be 
a change in the drive information in Windows 2000 
compared to the recovery environment.

If the error continues to occur during the use of the 
Recover My Computer Wizard from the recovery 
environment, you should contact technical support. 

E0BB0004
You are creating or restoring a recovery point using 
Norton Ghost. Immediately after you click Finish, you see 
"Error E0BB0004: Function Copy Volume argument 
Destination is invalid." You can back up other volumes 
without seeing error messages.

Be sure that files and free space are not fragmented. Run 
a disk defragmentation tool that not only defragments 
files, but also defragments free space (moves the files to 
the beginning of the partition). Norton Speed Disk is 
recommended. 

Severe fragmentation can prevent Norton Ghost from 
getting a “clear” recovery point of the drive.

E0BB001B 
Cannot lock volume “\\volume_name” because it 
contains the operating system or it has an active paging 
file.

Norton Ghost can back up operating system partitions 
and other partitions containing page files. This error is 
usually caused by a driver conflict with another 
application that may have control of the partition.

Check for other applications that may have a lock on the 
drive and temporarily disable any suspected conflicting 
drivers, then run Norton Ghost again to create the 
recovery point.
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E0BB0097
If the error occurs when attempting to restore a recovery 
point to a partition, delete the partition first. If the error 
occurs when attempting to create a recovery point of a 
partition, please contact Symantec technical support.

E0BB0147
When trying to perform a backup operation, Norton 
Ghost reports, "Error E0BB0147: The operation 'Snap 
Volume' is not currently enabled for this Volume."

One of the following may cause this error message with 
the SymSnap.sys driver:

1 The driver does not load properly during the Windows 
startup process.

1 The driver is not properly registered in the Windows 
registry.

1 The driver does not exist in the 
%SystemRoot%\System32\Drivers folder

To resolve the problem, check the following: 

1 Confirm that SymSnap.sys exists in the 
%SystemRoot%\System32\Drivers folder.

1 Confirm that SymSnap appears in System Information 
> Software Environment > System Drivers.

E0BC000A 
The saved initial state for applying changes does not 
match the current system state.

You should try restoring using Symantec Recovery Disk.

1 This error can also be caused by fiber channel 
devices.
Disconnect the devices to confirm whether or not they 
are causing the problem.

1 This error may also be caused by Emulex controllers. 
Occasionally there are phantom volumes or partition 
table errors that can cause this error. Contact 
Symantec technical support.
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E7C3000F
This error message may indicate that there are bad 
sectors or corrupted files on the hard disk. Run CHKDSK 
/R (or CHKDSK /P) at least four to six times, and then try 
backing up again. 

If the problem persists, you can still create a recovery 
point by disabling bad-sector checking and recovery 
point verification in Norton Ghost. However, this does not 
solve the problem of bad sectors on the hard disk. As a 
result, there is no guarantee that the recovery point will 
be valid or capable of being successfully restored. 

E7D1001F
Unable to write to the file. This error can occur if you do 
not have the correct rights. However, it could also be 
caused by slow bandwidth, dropped packets, or other 
network-related issues.

Contact Symantec technical support.

E926001F
File cluster chain length does not match file size 
requirements.

Run the Windows chkdsk utility on the source drive 
before you copy the recovery point or you create a 
recovery point. If this is not possible, and you have 
confirmed that the recovery point is valid, you can 
bypass the error by deselecting the restore option Check 
file system after restore. After you have finished 
restoring the recovery point, run chkdsk on the drive to 
eliminate any file system errors.

EA39070A 
The internal structure of the recovery point file is invalid 
or unsupported when saving the file to a network 
location.

This error can also occur for one of the following reasons:
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1 The recovery point file is damaged or corrupted.
Damage can occur when you create a recovery point 
over a network and there is significant packet loss 
during the creation of the recovery point file.
You should verify recovery point after they are 
created to ensure their integrity.
Create a new recovery point file to a different location, 
or create a new recovery point with a different file 
name to the same location.

1 The recovery point file is fine, but there may be a 
conflict with spyware detection software (such as Pest 
Control or Spybot) causing the recovery point file to 
become corrupt or appear to be corrupted.
While using the product or Recovery Point Browser, 
disable all spyware detection software.

1 If you copy a recovery point file from one FireWire 
drive to another FireWire drive while connected to a 
FireWire expansion card that uses a Via chipset (such 
as the Kouwell card).
To work around this issue, replace your Via-based 
FireWire expansion card with a card that uses a non-
Via chipset (such as the Adaptec 4300 Fireconnect, 
which uses a TI chipset).

EA390712 
Open failed. 

This error is usually caused by insufficient rights to the 
Norton Ghost agent service. A user must have 
administrator and domain administrator rights on the 
sub-share folder. Check that the Norton Ghost agent 
services Log On information is correct.

EBAB001A
Cannot read data from drive. An unknown exception has 
occurred. 

This error is reported when you are attempting to save a 
recovery point to removable media. If you are saving a 
recovery point to removable media, insert a disk into the 
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drive. If that does not work, disconnect the removable 
media drive and remove any attached USB devices.

EC8A0001:The engine has not been initialized
See “Cannot access 
the network drive 
where recovery 
points are saved” 
on page 133.

This error is caused by updated firmware on QLogic 
drives conflicting with the QLogic driver on the product 
CD. In other cases it could also be caused by any SCSI 
conflict with particular drivers on the product CD.

Try loading the driver manually.

If the error continues, run the recovery environment 
support utilities Display SME Disk Information and View 
Partition Information, obtain system information, and 
then contact technical support. Additional log files may 
also be needed.

EC8F0007
The error is usually caused by a driver conflict with 
another application that may have control of the 
partition. Check for other applications that may have a 
lock on the drive. Temporarily disable any suspected 
conflicting drivers and run Norton Ghost again.

EC8F000C
Cannot find the virtual volume image driver.

This error is typically occurs when the virtual volume 
imaging driver (symsnap.sys) has been incorrectly 
installed. You should uninstall and then reinstall the 
product to correct this error. Your existing backups and 
recover points will not be affected, provided you instruct 
the uninstall not to remove them.

EC950001
This error occurs when the driver for the storage 
controller does not load in Symantec Recovery Disk. 
Restart the computer using Symantec Recovery Disk and 
press F6 to load the necessary drivers.
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Error: The object invoked has disconnected from 
its clients

If you encounter this error, the computer (typically a 
remotely managed computer) has either crashed or the 
agent service has stopped running.

Catastrophic error
This may be caused by a conflict with another program. 
Contact technical support.

WinBOM error when starting the recovery 
environment

This is an issue with the NIC (Network Interface Card) 
driver not loading. If the recovery point you want to 
restore is located on the network, you should first try a 
different NIC card. If that is usuccessful, you will need to 
send the drivers and a system information file to 
technical support.

The month and year are reversed on some 
international computers

This is an issue with some international servers. Send 
the .PQH files to technical support.

Norton Ghost agent and Windows 
Services

The Norton Ghost agent runs as a service rather than as a 
desktop application. Running the agent as a service 
allows scheduled backups to run even if no one (or an 
unprivileged user) is logged on to the computer. 

Because the agent runs as a service, you can use the 
Services tool in Windows if you ever need to start, stop, 
configure the password, or troubleshoot the agent. 
Checking the agent in Services can be an invaluable tool 
for solving a problem with the software. If the agent is 
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not starting on a computer, you will have problems 
creating and restoring recovery points.

Using the Services tool, you can manage the agent in the 
following ways:

Viewing the status of a agent
There are several methods you can use to open Services 
to view the status of the agent. Use the method that is 
most convenient for you.

To view the status of the agent

1 On the Windows taskbar, do one of the following:
2 Click Start > Settings > Control Panel > 

Administrative Tools > Services.
2 Click Start > Run. In the Open text field, type 

services.msc, and then click OK.
2 If you are running Windows XP, click Start > 

Control Panel > Performance and 
Maintenance > Administrative Tools, and then 
double-click Services.

See “Starting, 
stopping, or 
restarting the 
agent service” on 
page 145.

2 Scroll the list of services until you see Norton Ghost 
(the name of the agent) under the Name column.
Its status should be set as Started.

Start, stop, or 
disable the agent 
on local and 
remote computers

See “Starting, stopping, or restarting 
the agent service” on page 145.

Configure the user 
name and 
password used by 
the agent

See “Adding users who can back up 
a computer” on page 67.

Set up recovery 
actions to take 
place if the agent 
fails to start

For example, you can restart the 
agent automatically or restart the 
computer.

See “Setting up recovery actions 
when the agent fails to start” on 
page 147.
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Best practices for using services
The agent service is a critical component for creating 
recovery points. To minimize problems with the agent, 
there are a number of steps you can take. 

The following table lists various tasks that you should 
check or use.

Check the 
event log 
first before 
using 
Services

The event log should be the first place 
you check when tracking down the 
source of a problem, particularly when it 
is associated with the agent. Selecting 
the most recent log entries often gives 
you information and clues as to what is 
causing the problem.

On the Status panel, click View Event 
Log.
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Starting, stopping, or restarting the agent service
To start, stop, or restart the agent service, you must be 
logged on as an administrator. If your computer is 
connected to a network, network policy settings may also 
prevent you from completing this task.

Verify that 
the agent is 
starting 
without user 
intervention

When the agent is installed on a 
computer, it is configured to start 
automatically when Norton Ghost starts.

You can test that the agent is starting 
automatically by looking in Services, 
checking the status, and then restarting 
the service if necessary. If the Startup 
type is set to automatic, you should try 
starting the agent again.

See “Starting, stopping, or restarting the 
agent service” on page 145.

Use caution 
when 
changing 
default 
settings for 
the agent

Changing the default settings for services 
might prevent key services from running 
correctly. It is especially important to use 
caution when changing the Startup Type 
and Log On As settings of services that 
are configured to start automatically.

Changing the default agent properties 
may prevent Norton Ghost from running 
correctly. In particular, you should use 
caution when changing the default 
Startup type and Log On settings of the 
agent since it is configured to start and 
(typically) log on automatically when 
you run Norton Ghost.
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Some instances of when you may need to start, stop, or 
restart the agent service include the following:

To start, stop, or restart the Agent

See “Viewing the 
status of a agent” 
on page 143.

1 In the Services window, select Norton Ghost under 
the Name column.

2 Do one of the following: 

Stopping the agent service will prevent you from 
creating or restoring recovery points from Norton 
Ghost.
If you stop the agent service and then start Norton 
Ghost, the agent will restart automatically.
If you stop the agent service while Norton Ghost is 
open, you will receive an error message and Norton 
Ghost will be disconnected from the agent. 

Start or 
Restart

If Norton Ghost is unable to connect to the 
agent on a computer.

Restart You have just changed the user name or 
password (or both) you use to log on to the 
agent service, or you used the Security 
Configuration Tool to give additional users the 
ability to back up computers. 

See “Adding users who can back up a computer” 
on page 67.)

Stop If you believe the agent may be causing a 
problem on the computer, or you want to 
temporarily free memory resources. If you 
have defined a backup, note that stopping 
the agent will prevent recovery points from 
being created at the scheduled times you 
specified.

Click Action > Start Starts the agent

Click Action > Stop Stops the agent

Click Action > Restart Restarts the agent
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Setting up recovery actions when the agent fails 
to start

You can specify the computer’s response if the agent fails 
to start. 

To set up recovery actions

See “Viewing the 
status of a agent” 
on page 143.

1 In the Services window, select Norton Ghost under 
the Name column.

2 Click Action > Properties.

3 Click Recovery.

4 In the First failure, Second failure, and Subsequent 
failure drop-down list, select one of the following 
actions:

5 In the Reset fail count after text box, specify the 
number of days that the agent must run successfully 
before the fail count is reset to zero. 
When the fail count is reset to zero, the next failure 
triggers the action set for the first recovery attempt.
If you want the agent to run correctly for several 
weeks between failures, you should specify a large 
number.

6 Click OK.

Restart 
the 
Service

Specify the number of minutes to pass 
before an attempt to restart the service 
is made.

Run a 
Program

Specify a program to run. You should not 
specify any programs or scripts that 
require user input.

Restart 
the 
Computer

Specify how long to wait before 
restarting the computer by clicking 
Restart Computer Options. You can also 
create a message that you want to 
display to remote users before the 
computer restarts.
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Viewing agent dependencies
The agent depends on other required services to run 
properly. If a system component is stopped or is not 
running properly, dependent services can be affected.

An instance of when you would want to view the agent 
dependencies is if the agent fails to start. Check the 
dependencies to ensure they are installed and that their 
Startup type (as identified in the General tab) is not set to 
Disabled.

The top list box on the Dependencies tab displays 
services that are required by the agent to run properly. 
The bottom list box does not have any services that need 
the agent to run properly.

The following table lists the three services that are 
required by the Norton Ghost agent to run properly, 
along with their default Startup type setting (as listed in 
the General tab).

To view agent dependencies

See “Viewing the 
status of a agent” 
on page 143.

1 In the Services window, select Norton Ghost under 
the Name column.

2 Click Action > Properties.

3 Click Dependencies.

Service Startup Type

Event Log Automatic

Logical Disk Manager Automatic

Remote Procedure Call (RPC) Automatic
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The Service & Support Web site at  
http://service.symantec.com supports Symantec 
products. Customer Service helps with nontechnical 
issues such as orders, upgrades, replacements, and 
rebates. Technical Support helps with technical issues 
such as installing, configuring, or troubleshooting 
Symantec products.

Methods of technical support and customer service can 
vary by region. For information on support offerings in 
your region, check the appropriate Web site listed in the 
sections that follow.

If you received this product when you purchased your 
computer, your computer manufacturer may be 
responsible for providing your support.

Customer service
The Service & Support Web site at  
http://service.symantec.com tells you how to:

1 Subscribe to Symantec newsletters.

1 Locate resellers and consultants in your area.

1 Update your product registration.

1 Find out about orders, returns, or a rebate status.

1 Access Customer Service FAQs.

1 Post a question to a Customer Service representative.

1 Obtain product information, literature, or trialware.
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For upgrade orders, visit the Symantec Store at:  
http://www.symantecstore.com

Technical support
Symantec offers two technical support options for help 
with installing, configuring, or troubleshooting Symantec 
products:

1 Online Service and Support
Connect to the Symantec Service & Support Web site 
at http://service.symantec.com, select your user type, 
and then select your product and version. You can 
access hot topics, Knowledge Base articles, tutorials, 
contact options, and more. You can also post a 
question to an online Technical Support 
representative.

1 PriorityCare telephone support
This fee-based (in most areas) telephone support is 
available to all registered customers. Find the phone 
number for your product at the Service & Support 
Web site. You will be led through the online options 
first, and then to the telephone contact options.

Support for old and discontinued versions
When Symantec announces that a product will no longer 
be marketed or sold, telephone support is discontinued 
60 days later. Technical information may still be 
available through the Service & Support Web site at:  
http://service.symantec.com

Subscription policy
If your Symantec product includes virus, firewall, or Web 
content protection, you may be entitled to receive 
updates via LiveUpdate. Subscription length varies by 
Symantec product.

After your initial subscription ends, you must renew it 
before you can update your virus, firewall, or Web 
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content protection. Without these updates, you will be 
vulnerable to attacks.

When you run LiveUpdate near the end of your 
subscription period, you are prompted to subscribe for a 
nominal charge. Simply follow the instructions on the 
screen. 

Worldwide service and support
Technical support and customer service solutions vary 
by country. For Symantec and International Partner 
locations outside of the United States, contact one of the 
service and support offices listed below, or connect to 
http://service.symantec.com and select your region or 
language under Global Support.

Service and support offices

North America

Symantec Corporation 
555 International Way 
Springfield, OR 97477 
U.S.A.

http://www.symantec.com/

Australia and New Zealand

Symantec Australia 
Level 2, 1 Julius Avenue 
North Ryde, NSW 2113 
Sydney 
Australia

http://www.symantec.com/region/
reg_ap/ 
+61 (2) 8879-1000 
Fax: +61 (2) 8879-1001

Europe, Middle East, and Africa

Symantec Ltd 
Consumer Services & Support 
PO Box 5689 
Blanchardstown, Dublin 15 
Ireland

http://www.symantec.com/region/
reg_eu/ 
+353 (1) 811 8032

Latin America
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Symantec Brasil 
Market Place Tower 
Av. Dr. Chucri Zaidan, 920 
12° andar 
São Paulo - SP 
CEP: 04583-904 
Brasil, SA

Portuguese:  
http://www.service.symantec.com/br 
Spanish: 
http://www.service.symantec.com/mx 
Brazil: +55 (11) 5189-6300 
Mexico: +52 55 5322 3681 (Mexico DF) 
01 800 711 8443 (Interior) 

August 12, 2004
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